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Brief Description
The Art Text application is designed for creating unique textual graphics by applying effects to text and
vector shapes. Your work can be saved in the native Art Text format or in common graphic file formats.

Images created in Art Text can be used in publishing materials, on web pages, or in other applications.

In Art Text, you will find:

2D effects (such as shadow, glow and stroke)
3D effects (such as adjustable color, shape and light)
Transformations (geometric deformation of text or images)
Libraries of textures, backgrounds and other graphic content
Tools and templates to create AI-generated images

The program is supplied with well-tuned templates and presets which can serve as a starting point for your
designs.

System Requirements

macOS 10.14 or later
2 GB of available disk space
Metal-capable video card

To find out if your video card is Metal-capable:

Use the Mac computers that support Metal page.
Open Applications/Utilities/System Information.app. Then navigate to Graphics/Displays in the
Hardware section. Make sure that there is "Supported…" next to Metal.

https://support.apple.com/en-us/HT205073
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Licensing
The Online Store in the Design Gallery offers you to purchase design sets. Once purchased, a set enables
you to download and use the included designs. The store will send you a confirmation email with a license
code related to the purchased set. It is recommended that you keep that email or its contents in a safe place
in case you reinstall or update the application.

After reinstalling the app, it may display previously purchased sets as not purchased. In such a case:

1. Open the Restore Purchases dialog by choosing Art Text 4 > Restore Purchases… from the menu.
2. Click the Add License… button.
3. Copy a license code from the purchase confirmation email and paste it into the field.
4. Click OK.
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Updating the Program

To check for updates manually, choose Art Text 4 > Check for Updates… in the menu.

To check for updates automatically, select the corresponding check box in the program Preferences (Cmd-,).

To update the application purchased on the Mac App Store, use the App Store application.
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Removing the Program
To completely remove the program and all of its components, delete the following files and folders:

/Applications/Art Text 4.app
~/Library/Containers/com.belightsoft.ArtText4

“~” means the user's Home folder.

Note that folders marked with bold font can store user's 2D and 3D materials, and custom shapes. Don’t
remove these folders if you are going to use your materials or shapes in the future.

To access any path listed above, copy it. In Finder, choose Go > Go to Folder (Cmd-Shift-G). Then paste
the path into the edit box, and click the Go button.
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Technical Support
The developer of Art Text offers free technical support.

By email: 
support@belightsoft.com

Technical support form on BeLight’s website: 
https://text.design/support/#art-text

When reporting a problem, please make sure to specify:

The version of Art Text you are using.
The version of macOS installed on your computer.
Your actions that could have led to the problem.
If the problem persists, describe how to reproduce it.
When necessary, illustrate your report with screenshots (press Cmd-Shift-3 to save a screenshot on
your Desktop).

mailto:support@belightsoft.com
https://text.design/support/#art-text
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Useful Web Resources
Art Text Home – Information about Art Text, links to the Download, Latest Update, Buy, and FAQ sections.

Art Text Support – Visit this link if you have questions about the software.

https://text.design/art-text
https://text.design/support/#art-text
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End User License Agreement
THIS LICENSING AGREEMENT ("AGREEMENT") IS A LEGAL AGREEMENT BETWEEN YOU, EITHER AN
INDIVIDUAL OR A SINGLE ENTITY, AND BELIGHT SOFTWARE ("LICENSOR"). IF YOU DO NOT AGREE TO
EACH AND EVERY TERM, YOU ARE TO CLICK "DISAGREE" BUTTON AND NOT TO OPEN, USE OR
INSTALL THE SOFTWARE AND YOU MUST DELETE THE SOFTWARE FROM YOUR COMPUTER AND/OR
ANY OTHER DATA STORAGE DEVICE.

NOTE: Mac App Store customers should refer to the standard App Store EULA.

1. GENERAL
The software and documentation accompanying this License whether on disk, on any other media
(collectively the "Software") are licensed to you by BeLight Software ("Licensor") for use only under the terms
of this License, and Licensor reserves all rights not expressly granted to you. The rights granted herein do not
include any other patents or intellectual property rights.

Title and intellectual property rights in and to any content displayed by or accessed through the Software
belong to the respective content owner. This License does not grant you any rights to use such content
outside Art Text.

2. LICENSE
Licensor hereby grants to You, and You accept, a non-exclusive license to install and use Software and
Documentation, only as authorized in this license. The license permits either multiple users to install and use
the software on a single computer, or a single user to install and use the software on multiple computers. The
license doesn't allow multiple users to use the Software on multiple computers. You agree that You will not
assign, sub license, transfer, pledge, lease, rent, or share Your rights under this license. You may not reverse
engineer, decompile or disassemble the Licensed Software for any purpose whatsoever.

Graphic Content: The Software contains numerous templates, photo images, fonts, and other graphic
content (collectively known hereafter as "Graphic Content") that are either owned by Licensor or licensed
from a third party. You are free to use and modify the Graphic Content within Art Text software as you wish
for Personal and Commercial purposes subject to the restrictions set out in this section. If you are uncertain
about your rights to use any material, you should contact your legal advisor.

You may NOT resell, sublicense or otherwise make available the Graphic Content for use or distribution
separately or detached from a product or Web page. You may NOT a) create scandalous, obscene,
defamatory or immoral works using the Graphic Content nor use the Graphic Content for any other purpose
which is prohibited by law; b) use or permit the use of the Graphic Content or any part thereof as a trademark
or service mark, or claim any proprietary rights of any sort in the Graphic Content or any part thereof; c) use
the Graphic Content in electronic format, on-line or in multimedia applications unless the Graphic Content
are incorporated for viewing purposes only and no permission is given to download and/or save the Graphic
Content for any reason; d) use any Graphic Content except as expressly permitted by this License; and e)
use the Graphic Content related to identifiable individuals, products or entities for any commercial purpose or
in a manner which suggests their association with or endorsement of any product or service.

3. TRANSFER
You may not distribute copies of the Software to any third party, nor may you use, rent, loan, sub-license, or
lease the Software to third parties. You may, however, transfer all your rights to use the Software to another
person or legal entity provided that: (a) You also transfer this Agreement, the Software and all other software
bundled or pre-installed with the Software, including all copies, Updates and prior versions, to such person
or entity; (b) You retain no copies, including backups and copies stored on a computer; and (c) the receiving
party accepts the terms and conditions of this Agreement and any other terms and conditions upon which
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You legally obtained license to the Software. Notwithstanding the foregoing, You may not transfer pre-release
or not for resale copies of the Software.

4. ILLEGAL USE
You are not to use the Software, whether directly or indirectly, for any illegal purpose under the laws or
ordinances of Federal, State, or local governments. It is Your sole responsibility to know and understand the
laws and/or ordinances that govern the use of the Software. In the event that You violate any Federal, State
or local law or ordinance by direct or indirect use of the Software, You shall take full legal responsibility for
such illegal use. You shall hold Licensor harmless and without fault and otherwise indemnify Licensor for any
damage, cost or liability incurred by Licensor as a result of any use, whether or not such use is within the
scope of the license set forth herein.

5. ARTIFICIAL INTELLIGENCE
This is new technology and it does not always work as expected. No guarantees are made as to the
suitability of the Assets for the Customer. Your use of the Service is at your sole risk. The Service is provided
on an "AS IS" and "AS AVAILABLE" basis. The Service is provided without warranties of any kind, whether
express or implied, including, but not limited to, implied warranties of merchantability, fitness for a particular
purpose, non-infringement or course of performance.

Licensor and its subsidiaries, affiliates, and its licensors do not warrant that:
a) the Service will function uninterrupted, secure or available at any particular time or location;
b) any errors or defects will be corrected;
c) the results of using the Service will meet your requirements.

Licensor claims no rights in the Output You generate using the Model. You are accountable for the Output
you generate and its subsequent uses. No use of the output can contravene any provision as stated below.

Use Restrictions

You agree not to use the the AI Wizard or its derivatives:
- In any way that violates any applicable national, federal, state, local or international law or regulation;
- For the purpose of exploiting, harming or attempting to exploit or harm minors in any way;
- To generate or disseminate verifiably false information and/or content with the purpose of harming others;
- To generate or disseminate personal identifiable information that can be used to harm an individual;
- To defame, disparage or otherwise harass others;
- For fully automated decision making that adversely impacts an individual’s legal rights or otherwise creates
or modifies a binding, enforceable obligation;
- For any use intended to or which has the effect of discriminating against or harming individuals or groups
based on online or offline social behavior or known or predicted personal or personality characteristics;
- To exploit any of the vulnerabilities of a specific group of persons based on their age, social, physical or
mental characteristics, in order to materially distort the behavior of a person pertaining to that group in a
manner that causes or is likely to cause that person or another person physical or psychological harm;
- For any use intended to or which has the effect of discriminating against individuals or groups based on
legally protected characteristics or categories;
- To provide medical advice and medical results interpretation;
- To generate or disseminate information for the purpose to be used for administration of justice, law
enforcement, immigration or asylum processes, such as predicting an individual will commit fraud/crime
commitment (e.g. by text profiling, drawing causal relationships between assertions made in documents,
indiscriminate and arbitrarily-targeted use).

Third-Party AI Models

AI models and derivatives of models used in Art Text. When generating AI images with Art Text, you also
agreeing to comply with the following third-party terms and conditions:
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Stable Diffusion
https://github.com/CompVis/stable-diffusion/blob/main/LICENSE

Depth Anything
https://github.com/LiheYoung/Depth-Anything/blob/main/LICENSE

ControlNet
https://github.com/lllyasviel/ControlNet/blob/main/LICENSE

ControlNet Canny SDXL
Apache 2.0 License

RealESRGANer
Apache Software License (BSD-3-Clause License)

Diffusers
https://github.com/huggingface/diffusers/blob/main/LICENSE

6. UPDATES
You may continue to use the previous version of the Software on your computer after You receive the Update
to assist You in the transition to the Update, provided that: the Update and the previous version are installed
on the same computer; the previous version or copies thereof are not transferred to another party or
computer unless all copies of the Update are also transferred to such party or computer; and You
acknowledge that any obligation BeLight Software may have to support the previous version of the Software
may be ended upon availability of the Update.

7. LICENSOR'S RIGHTS
You acknowledge and agree that the Software and Documentation consists of proprietary, published and
unpublished property of Licensor. You further acknowledge and agree that all right, title, and interest in and to
the Software and Documentation are and shall remain with Licensor. This license conveys to You the right to
install and use the Software and Documentation in accordance with the terms of this license. All rights not
expressly granted here are reserved by BeLight Software. The Licensor will not transmit your personal
information to any third party without your express consent.

8. TERMINATION
This license is effective upon Your installing the software on any machine, and shall continue until terminated.
You may terminate this Agreement at any time. The Licensor may immediately terminate this License
Agreement if you breach any representation, warranty, agreement or obligation contained or referred to in this
License Agreement. Upon termination, you must dispose of the Software and all copies or versions of the
Software by destroying the Software.

9. LIMITED WARRANTY
BELIGHT SOFTWARE DISCLAIMS ALL WARRANTIES, EXPRESS OR IMPLIED, INCLUDING BUT NOT
LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE, WITH REGARD TO THE LICENSED SOFTWARE AND ALL ACCOMPANYING MATERIALS.
BELIGHT SOFTWARE AND ITS AGENTS DO NOT AND CANNOT WARRANT THE PERFORMANCE OR
RESULTS YOU MAY OBTAIN BY USING THE SOFTWARE.

10. LIMITATION OF LIABILITY
IN NO EVENT WILL BELIGHT SOFTWARE OR ITS AGENTS BE LIABLE TO YOU FOR ANY DAMAGES,
CLAIMS OR COSTS WHATSOEVER OR ANY CONSEQUENTIAL, INDIRECT, INCIDENTAL DAMAGES, OR
ANY LOST PROFITS OR LOST SAVINGS. BELIGHT SOFTWARE'S AGGREGATE LIABILITY AND THAT OF
ITS AGENTS UNDER OR IN CONNECTION WITH THIS AGREEMENT SHALL BE LIMITED TO THE AMOUNT
PAID FOR THE SOFTWARE, IF ANY.

https://github.com/CompVis/stable-diffusion/blob/main/LICENSE
https://github.com/LiheYoung/Depth-Anything/blob/main/LICENSE
https://github.com/lllyasviel/ControlNet/blob/main/LICENSE
https://github.com/huggingface/diffusers/blob/main/LICENSE
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11. SEVERABILITY
Should any term of this license be declared void or unenforceable by any court of competent jurisdiction,
such declaration shall have no effect on the remaining terms hereof.

12. GENERAL PROVISIONS
This License Agreement is personal between You and BeLight Software. It is not transferable and any
attempt by You to rent, lease, sublicense, assign or transfer any of the rights, duties or obligations hereunder.
YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT, UNDERSTAND IT AND AGREE TO BE
BOUND BY ITS TERMS AND CONDITIONS. YOU FURTHER AGREE THAT IT IS THE COMPLETE AND
EXCLUSIVE STATEMENT OF THE AGREEMENT BETWEEN YOU AND BELIGHT SOFTWARE WHICH
SUPERSEDES ANY PROPOSAL OR PRIOR AGREEMENT, ORAL OR WRITTEN, AND ANY OTHER
COMMUNICATIONS BETWEEN YOU AND BELIGHT SOFTWARE OR BELIGHT SOFTWARE'S AGENT(S)
RELATING TO THE LICENSED SOFTWARE.

If you have any questions regarding this Agreement or if you wish to request any information from BeLight
Software, please use the address and contact information included with this product to contact BeLight
Software.

© 2025 BeLight Software, Ltd. All Rights Reserved. BeLight Software and Art Text are trademarks of BeLight
Software, Ltd. Mac, the Mac logo, macOS, Photos, and Macintosh are trademarks of Apple Computer, Inc.
All other trademarks, registered trademarks, product and/or brand names are the sole property of their
respective owners.
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BeLight Software Privacy Statement
Your privacy is important to us. This Privacy Statement covers how we collect, use, disclose, transfer and
store your information.

Collection and Use of Personal Information

Personal information is data that can be used to identify or contact a single person.

You may be asked to provide your personal information any time you are in contact with BeLight Software.
We may share and use this information consistent with this Privacy Statement. We may also combine it with
other information to provide and improve our products, services, content and advertising. You are not
required to provide the personal information that we have requested, but, if you choose not to do so, in many
cases, we will not be able to provide you with our products or services or respond to any queries you may
have.

What personal information we collect:

When you purchase a product, download software or an update, register for company or product
newsletters, contact us or participate in an online survey, we may collect a variety of information, including
your name, mailing address, phone number and email address.

How we use your personal information:

The personal information we collect allows us to keep you posted on BeLight Software's latest product
announcements, software updates and upcoming events. If you don't want to be on our mailing list,
you can opt out any time by emailing us at: news@belightsoft.com
We also use personal information to help us create, develop, operate, deliver and improve upon our
products, services, content and advertising, as well as for loss prevention purposes.
We may use your personal information to verify identity, assist with identification of users and
determine appropriate services.
From time to time, we may use your personal information to send important notices, such as
communications about purchases and changes to our terms, conditions and policies. Because this
information is important to your interaction with BeLight Software, you may not opt out of receiving
these communications.
We may also use personal information for internal purposes, such as auditing, data analysis and
research to improve BeLight Software products, services and customer communications.
If you enter into a sweepstakes, contest or similar promotion, we may use the information you provide
to administer those programs.

Collection and Use of Non-personal Information

We also collect data in a form that does not, on its own, permit direct association with any specific individual.
We may collect, use, transfer and disclose non-personal information for any purpose. The following are some
examples of non-personal information that we collect and how we may use it:

We may collect information such as occupation, language, zip code, area code, unique device
identifier, referrer URL, location and the time zone where a BeLight Software product is used so that
we can better understand customer behavior and improve our products, services and advertising.
We may collect information regarding customer activities on our websites and from our other products
and services. This information is aggregated and used to help us provide more useful information to
our customers and to understand which parts of our website, products and services are of most

mailto:news@belightsoft.com
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interest. Aggregated data is considered non-personal information for the purposes of this Privacy
Statement.

If we do combine non-personal information with personal information, the combined information will be
treated as personal information for as long as it remains combined.

Cookies and Other Technologies

BeLight Software websites, online services, interactive applications, email messages and advertisements
may use "cookies" and other technologies, such as pixel tags and web beacons. These technologies help us
better understand user behavior, tell us which parts of our websites people have visited and facilitate and
measure the effectiveness of advertisements and web searches. We treat information collected by cookies
and other technologies as non-personal information. However, to the extent that Internet Protocol (IP)
addresses or similar identifiers are considered personal information by local law, we also treat these
identifiers as personal information. Similarly, to the extent that non-personal information is combined with
personal information, we treat the combined information as personal information for the purposes of this
Privacy Statement.

If you want to disable cookies, and you're using the Safari web browser, go to Safari Preferences and then to
the Privacy pane to manage your preferences. For other browsers, check with your provider to find out how
to disable cookies. Please note that certain features of the BeLight Software website will not be available
once cookies are disabled.

We use this information to understand and analyze trends, to administer the site, to learn about user behavior
on the site, to improve our product and services and to gather demographic information about our user base
as a whole. BeLight Software may use this information in our marketing and advertising services.

In some of our email messages, we use a "click-through URL" linked to content on the BeLight Software
website. When customers click one of these URLs, they pass through a separate web server before arriving
at the destination page on our website. We track this click-through data to help us determine interest in
particular topics and measure the effectiveness of our customer communications. If you prefer not to be
tracked in this way, you should not click text or graphic links in the email messages. Pixel tags enable us to
send email messages in a format customers can read, and they tell us whether mail has been opened. We
may use this information to reduce or eliminate messages sent to customers.

Disclosure to Third Parties

At times, BeLight Software may make certain personal information available to strategic partners that work
with BeLight Software to provide products and services or that help BeLight Software market to customers.
Personal information will only be shared by BeLight Software to provide or improve our products, services
and advertising; it will not be shared with third parties for their marketing purposes.

Service Providers

BeLight Software shares personal information with companies that provide services such as information
processing, fulfilling customer orders, delivering products to you, managing and enhancing customer data,
providing customer service, assessing your interest in our products and services and conducting customer
research or satisfaction surveys. These companies are obligated to protect your information.

Services we use and their respective privacy policies:

Google Analytics is used to analyze website visitors' behavior and activity:
https://policies.google.com/privacy

https://policies.google.com/privacy
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Vimeo is used for video content playback:
https://vimeo.com/privacy

FastSpring is used for online order processing:
https://fastspring.com/privacy/

Others

It may be necessary - by law, legal process, litigation and/or requests from public and governmental
authorities within or outside your country of residence - for BeLight Software to disclose your personal
information. We may also disclose information about you if we determine that disclosure is reasonably
necessary to enforce our terms and conditions or protect our operations or users. Additionally, in the event of
a reorganization, merger or sale, we may transfer any and all personal information we collect to the relevant
third party.

Artificial Intelligence Usage

Our software products may offer access to artificial intelligence (AI) to enhance your creative experience.
When you use the AI-powered feature, the prompt and image of your design may be sent to our server and
temporarily processed by our AI engine to generate results. We do not store or share your input data or
generated content with any third-party.

Whenever you use our software and/or the Artificial Intelligence feature in our software, rest assured, we
never share or use your work to train AI. We never use graphics users create in Art Text to train AI.

Protection of Personal Information

BeLight Software takes the security of your personal information very seriously. BeLight Software online
services, such as the BeLight Software website store and embedded into software store, protect your
personal information during transit using encryption such as Transport Layer Security (TLS). When your
personal data is stored by BeLight Software, we use computer systems with limited access and encrypted
storage.

When you use some BeLight Software products, services or applications, or post on a BeLight Software
forum, chat room or social networking service, the personal information and content you share is visible to
other users and can be read, collected or used by them. In these instances, you are responsible for the
personal information you choose to share or submit.

Integrity and Retention of Personal Information

BeLight Software will retain your personal information for the period necessary to fulfill the purposes outlined
in this Privacy Statement unless a longer retention period is required or permitted by law.

Access to Personal Information

Access, correction or deletion requests can be made via email at:
sales@belightsoft.com

Children

If we learn that we have collected the personal information of a child under 13, or equivalent minimum age
depending on jurisdiction, we will take steps to delete the information as soon as possible.

Parents can contact us via email at:
sales@belightsoft.com

https://vimeo.com/privacy
https://fastspring.com/privacy/
mailto:sales@belightsoft.com
mailto:sales@belightsoft.com
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Third-party Sites and Services

BeLight Software websites, products, applications and services may contain links to third-party websites,
products and services. Our products and services may also use or offer products or services from third
parties. Information collected by third parties, which may include such things as location data or contact
details, is governed by their privacy practices. We encourage you to learn about the privacy practices of
those third parties.

Commitment to Your Privacy

To ensure that your personal information is secure, we communicate our privacy and security guidelines to
BeLight Software employees and strictly enforce privacy safeguards within the company.

Questions

If you have any questions or concerns about the BeLight Software Privacy Statement or data processing, or
if you would like to make a complaint about a possible breach of local privacy laws, please contact us at:
sales@belightsoft.com

BeLight Software may update its Privacy Statement from time to time. When we change the policy in a
material way, a notice will be posted on our website along with the updated Privacy Statement.

mailto:sales@belightsoft.com
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Quick Start Guide
This guide will give you an idea of how you can create a new design in Art Text. There are many possible
ways to do that. Here, we are going to learn a simple method. Although the guide comprises a sequence of
steps, you can change their order, skip some of them, or add new ones.

For a better understanding of the location and names of the program controls, it is recommended that you
look through The Main Window section beforehand. An image below shows the most important parts of the
main window.

1 – Libraries of style presets, backgrounds, icons and shapes.

2 – The list of layers.

3 – The canvas.

4 – The Inspector.

5 – Sets of tools. To expand a set of tools, click on its title. Some tools have an On/Off switch or a choice of
presets next to the title.

6 – Add a new 2D or 3D object.

7 – Open the Design Gallery that contains samples of designs.

8 – The zoom tool.

9 – The Colorize button lets you access the Hue, Saturation and Brightness settings that can modify the
whole design.

10 – The Document Size button opens settings such as the size and measurement units.
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11 - Create an animation.

12 – Export to the Clipboard or file.

To learn the program, you may find it useful to open a finished design and try to modify it or explore what
kind of objects it is made of. To browse sample designs, choose Window > Design Gallery from the menu.
Then select the Design Gallery section at the top. In order to edit a design, double-click on it.

Step 1: Opening a new document

To open a new Art Text document, choose File > New. New documents have a text object by default. You
can either replace it with your own, or delete it in order to begin with a blank document. To do this, open the
layer list in the Content panel, and click the minus button.

For a quick start, you can open a sample from the library and then modify it.

Step 2: Setting up the document size

The document size defines the image dimensions when you export your design to a graphic file. To set up the
document size, click the Document Size button below the canvas. In the Document Size dialog, you can
also select the measurement units.

You can change the document size later at any time.
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Step 3: Adding text and images

To create a design based on a style preset, open the leftmost tab in the Content panel and select one of the
categories. Then drag and drop a design you like to your document.

To add text with the default style, click the plus button in the bottom left corner of the canvas and choose
either 2D or 3D Text.

In order to add images, open a collection of backgrounds in the Content panel:

or a library of shapes and icons:

Finally, drag one you like to your design.

Both text and images can be also called in the program "objects" and "layers" depending on the context.

Step 4: Moving and resizing objects

To move an object (text or image), just drag it with the mouse on the canvas.

In order to change the object size, select the object and move a handle on the object's boundary.

Step 5: Editing text

To edit text, select it on the canvas. Then click on the Text title in the Inspector to open the text editor. Modify
your text in the text editing box.
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Step 6: Applying effects

Applying effects is what Art Text documentation is all about, so we will not discuss any particular effect in this
guide. Most of the effects and tools are grouped in the Inspector as sections. To open a section, just click on
its title.

Note that 2D and 3D objects (you had to choose either 2D or 3D type in Step 3) let you use only those effects
which are compatible with the object type.

The Effect Guide lists the effects available in Art Text.

Once your design is ready, you can experiment with changing its colors. Using the Colorize button in the
main window, you can adjust the Hue, Saturation and Brightness of the whole design. This also lets you
create a unique design out of samples provided in the Design Gallery.

Step 7: Organizing layers in your document

When referring to layers, we mean that any object can appear on the canvas above or below other objects.
All layers of your document are listed in the Content panel. A layer at the top corresponds to an object which
is in front of others. To change this order, just drag a layer to a new position. In order to create a background,
add an image and make sure it is at the bottom of the list.

Apart from the possibility of rearranging layers, the layer list lets you add and delete layers using the plus and
minus buttons correspondingly.

Step 8: Saving your document

To save your document, choose File > Save from the menu.
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Step 9: Exporting the final image

To export your design to a graphic file, click the Export button in the bottom right corner of the canvas. Then,
choose either Clipboard or File.

The resolution for the Clipboard can be set in the Preferences dialog.

When you export to a file, you can choose the graphic format, resolution, and type a file name in the Export
dialog.
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Effect Guide
In this guide, you can find out the types of graphic effects that are available in Art Text.

Note that 2D and 3D objects have individual sets of effects. Usually, you can apply several effects to the
same object, but they must belong to the same 2D or 3D group.

2D Effects

Effect Sample Image Related Topic

Color Fill The Fill Effect

Gradient Fill The Fill Effect

Texture Applying Textures

Shading Applying Materials

Stroke The Stroke Effect

Shadow The Shadow Effect
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Glow The Glow Effect

Inner Shadow The Inner Shadow Effect

Mask The Mask Effect

Transformation Transformations

3D Effects

Effect Sample Image Related Topic

Material Applying Materials

Shadow The Shadow Effect
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Glow The Glow Effect

Focus The Focus Effect

Mask The Mask Effect

Transformation Transformations



26

Using Sample Designs
Art Text comes with a number of sample designs that you can use to learn the capabilities of the program as
well as to create your own artwork from the samples.

Style Presets in the Content Panel

Art Text provides a library of style presets located in the Content panel which can be found in the main
window. A typical preset is a piece of text with applied effects and a background.

To use a style preset, drag it to your document. Then edit text or adjust effects, if necessary.

The Design Gallery

To open the Design Gallery select Window > Design Gallery in the main menu or click  in the main
window.
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Note that the Design Gallery window has two more sections. Recent lists documents you edited recently.
Tutorials gives you access to online video tutorials.

Navigating Through the Gallery

The left panel of the gallery has a filter at the top that lets you show All, Generative AI, Free, Paid or
Purchased designs. So, if you consider using only free designs, select the Free category.

The middle part of the left panel lists sets of designs. As a rule, a set groups designs that were created using
the same technique or that have something else in common. You can sort the list of sets alphabetically or
show the newest ones at the top.

While searching for a design you might like, you can either scroll through all previews or select a particular
set by clicking on its name.

Each design has the magnification glass icon  in the bottom right corner. You can click on it to display a
bigger preview in the Preview Window.
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The Preview Window lets you preview all designs of the current set. The name of the set is displayed right
above the preview area.

To return back to the Design Gallery click the Back button at the top.

To edit the current design, click the Edit button at the top. Note that you can edit only built-in or downloaded
designs.

Download a Design

In order to download a design, click on its arrow icon .

You can download the whole set using the Download All button.

Some of the designs are free. Others need to be purchased before you can download them.

The price for the whole set is displayed at the beginning of the set. You can purchase it using the Buy Set
button below the name and description of the set.

The Deals category contains bundles which include multiple sets each. Some design sets can also be
purchased as a part of a bundle which is indicated below the description.

The designs that you have already purchased also become listed in the Purchased category.

Once a design is downloaded, its arrow icon  is replaced by the pencil icon .
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Edit a Design

To edit a design, click on the corresponding pencil icon . You can do the same by double-clicking on the
preview.

When you edit a design, you actually edit its copy. The original document will remain unchanged.
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The Main Window

1 - Libraries of icons, backgrounds and style presets.

Related subtopic: The Content Panel

2 - List of layers. Here you can access all of the objects in your document by their names or thumbnails.

Related subtopic: The List of Layers

3 - Canvas. This is the area where you preview and work with the design.

4 - Inspector. Depending on the selected object type, the Inspector shows either 2D or 3D tools and effects.

Related subtopics:
The 2D Inspector
The 3D Inspector

5 - Tools are grouped into sections. Only one section can be open at a time. To display hidden tools, click on
the title of the corresponding section. The title bar of some sections has a switch to activate or deactivate the
effect, or a drop-down menu with presets.

6 - Add a new 2D or 3D object, or a background.

7 – The Colorize button lets you access the Hue, Saturation and Brightness settings that can modify the
whole design.

8 - Open the Design Gallery.

9 - The zoom tool.
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10 - Open the AI Wizard.

11 - The Document Size button opens settings such as the document size and measurement units.

Related subtopic: Document Settings

12 - Create an animation.

Related subtopic: Creating and Exporting Animations

13 - Export to the Clipboard or file, or share the artwork with other software.

Related subtopics:
Exporting
Exporting your Design with a Depth Map
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Program Settings

To open program settings, use the Art Text 4 > Preferences… menu.

1 – Open the Design Gallery when the program starts. This window gives you access to sample documents
and to online resources related to the program.

2 – Resolution of images exported to the clipboard. It is important when you copy the final image to another
application.

3 – Automatically align an object to other objects when you move or resize it.

4 – Choose either a solid color for the document background or the chessboard. The selected type of the
background appears only on the canvas and will not be exported.

5 – Change the appearance of the user interface (UI). The Default option makes the program match the
system settings. The Light and Dark options let you choose the user interface mode manually. These options
take effect after restarting the program.

6 – Specifies whether the program should automatically check for updates. To check for updates manually,
choose Art Text 4 > Check for Updates… Users of the Mac App Store version of the program should use
AppStore.app to check for updates.
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The Content Panel
The Content panel is located to the left of the canvas. It consists of three libraries described below and the
List of Layers.

To show or hide the Content panel, use the View > Content Panel menu.

To add any item from the library to your design, drag it and drop it onto the canvas.

Style Presets

The Style Presets library includes samples of 2D and 3D texts with various effects applied. How to use style
presets is described in Using Sample Designs.

Backgrounds and Light Effects

Images from the Backgrounds section are intended to be used as a background in your design.

When you add a background to your document, the program automatically places it behind other objects,
and fits the image to the document dimensions. If you wish to place an added image above or below a



34

particular object, change the layer order in The List of Layers. To make the background image tiled, choose
this option in the Texture section of the Fill set of tools.

To add a background from the library, you can either click on the image preview or drag the image to the
document. If you have already added a background to your design, clicking on a new one will replace the old
background. Drag and dropping always adds one more image to your design.

Images from the Light Effects section can be used to enhance the 3D and illumination effects in your design.
These images are intended to be used with dark backgrounds.

One more category in the drop-down list is Photos. This is not a part of the library, but a quick way to access
pictures in your photo library.

In order to import an image from a graphic file, select Custom Folder… in the list.

Smart Shapes and Icons

Smart Shapes and icons are vector images. Therefore, you can resize them without the loss of quality. You
can also edit them in the vector editor which opens up by double-clicking on a vector image on the canvas.

The drop-down list at the top lets you choose one of the standard categories as well as the Custom Folder
option. The latter allows you to access your own images located on the hard disk.

You can store modified or new vector objects in the Custom Shapes category. To add an object to the library,
select it on the canvas and click the plus button in the Content panel. To delete a custom object from the
library, select it on the panel and click the minus button.
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The 2D Inspector
The 2D Inspector gathers all tools and effects that are specific for 2D objects. The Inspector switches to 2D
tools automatically as soon as you select a 2D object.

The tools are grouped into sections. To open a section, click on its title.

Some sections have a switch in the title bar allowing you to activate or deactivate the effect without need to
open the section.

Text

The Text section contains a text editor and formatting tools. This section is available only if a selected object
is text.

More details: The Text Editor



36

Fill

The Fill section includes four different tools. Here, you can choose to fill an object with a plain color or
gradient. A second option is to apply a texture to an object. The following option lets you apply a shading
material to an object giving it a 3D look. The last option scatters small images over the object.

More details:
The Fill Effect
Applying Textures
Applying Materials
Spray Effect

Effects

The Effects section contains multiple independent tools. Here, you can activate and set up effects such as
Shadow and Glow. You can also change the object's opacity and activate one of the blend modes.

More details:
The Shadow Effect
The Glow Effect
The Inner Shadow Effect
Applying Stroke
Distortion Effects

Mask

The Mask section lets you apply masks to objects.

More details: Applying Masks

Geometry

In the Geometry section, you can find tools to set up the object's dimensions and angle. There are also tools
to apply geometric transformations to objects.

Some Smart Shapes have one or two parameters in the Smart Shapes section. These parameters let you
change the shape of the image, for example, change the number of sides.

More details:
Object Size, Location and Orientation
Transformations
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The 3D Inspector
The 3D Inspector gathers all tools and effects specific for 3D objects. The Inspector switches to 3D tools
automatically as soon as you select a 3D object.

The tools are grouped into sections. To open a section, click on its title.

Text

The Text section contains a text editor and formatting tools. This section is available only if a selected object
is text.

More details: The Text Editor

Material

The Material section lets you apply materials to 3D objects. You can tweak the material properties, or you can
choose a predesigned material from the library. To open the library of predesigned materials, click on Preset
near the section title.

More details:
Applying Materials
Creating Materials
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Effects

In the Effects section, you can find tools to create the shadow, depth gradient, glow and focus effects. You
can also change the object's opacity and activate one of the blend modes.

More details:
The Shadow Effect
The Depth Gradient Effect
The Glow Effect
The Focus Effect

Mask

The Mask section contains the library of masks that you can apply to 3D objects. You can customize the
properties of the applied mask.

More details: Applying Masks

Geometry

The Geometry section includes various tools to set up the object's size and position in the design. There are
also tools to control the 3D effect and to apply 3D transformations.

More details: The 3D Object Settings
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Menus
Art Text 4
File
Edit
View
Layers
Format
Window
Help

The "Art Text" Menu

About Art Text Display the dialog with information about the program.

Restore Purchase… Open the Restore Purchases dialog box where you can re-enter your license
codes.

Check for Updates… Check for the latest update on the Internet. (Not available in the application
purchased on the Mac App Store.)

Preferences… (Cmd-",") Bring up the program preferences dialog.

Quit Art Text (Cmd-Q) Quit the application.

The "File" Menu

New (Cmd-N) Create a new document.

Open… (Cmd-O) Open a document.

Open Recent > Open one of the recently edited documents.

Close (Cmd-W) Close the open document window.

Save… (Cmd-S) Save the current document.

Duplicate (Cmd-Shift-S) Create a copy of the current document.

Rename… Rename the current document.

Move To… Move the current document to another location.

Revert To Cancel all of the changes in the current document that were made after the last
save.

Share Share the current design with other apps.

Export… (Cmd-E) Export the current document to a graphic file.

Facebook 3D Photo… Export the current document together with a depth map.

Page Setup… (Cmd-
Shift-P)

Open the standard Page Setup dialog for changing the size, orientation and
other parameters of the page.

Print… (Cmd-P) Bring up the standard Print dialog.
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The "Edit" Menu

Undo (Cmd-Z) Reverse the last operation that you performed.

Redo (Cmd-Shift-Z) Reverse the last Undo operation.

Cut (Cmd-X) Cut selected text (in the text editor only) to the Clipboard.

Copy (Cmd-C) Copy selected layer(s) to the Clipboard.

Paste (Cmd-V) Paste the content of the Clipboard to the document.

Duplicate (Cmd-D) Duplicate the selected layer(s).

Delete (Backspace) Delete the selected layer(s).

Copy Style Copy the style of the selected object.

Paste Style Apply the style to the selected object. You must copy a style before pasting it.

Select All (Cmd-A) Select all layers if the main window is activated.
Select all text in the text editor when text editing is activated.

Document Size… (Cmd-
Y) Open the Document Size dialog box.

Start Dictation… (fn fn) Dictate your text.

Emoji & Symbols (Cmd-
Ctrl-Space) Open the Emoji & Symbols panel.

The "View" Menu

Zoom In (Cmd-=) Zoom in the current view.

Zoom Out (Cmd-"-") Zoom out the current view.

Zoom to Fit Zoom the current view to fit the window.

Actual Size (Cmd-0) Display the actual document size.

Content Panel >
Show/Hide Show or hide the Content panel.

Content Panel > Style
Presets Open the Style Presets library.

Content Panel > Images Open the library of backgrounds and light effects.

Content Panel > Shapes Open the library of Smart Shapes, icons and vector images.

Content Panel > Layers Open the list of layers.
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Inspector > Show/Hide
(Cmd-Opt-I) Show or hide the Inspector.

Inspector > Text (Cmd-1)
Inspector > Fill (Cmd-2)
Inspector > Effects
(Cmd-3)
Inspector > Mask (Cmd-
4)
Inspector > Geometry
(Cmd-5)

Open a particular set of tools for 2D objects.

Inspector > Text (Cmd-1)
Inspector > Material
(Cmd-2)
Inspector > Effects
(Cmd-3)
Inspector > Mask (Cmd-
4)
Inspector > Geometry
(Cmd-5)

Open a particular set of tools for 3D objects.

Enter Full Screen / Exit
Full Screen (Cmd-Ctrl-F) Activate or deactivate the full screen mode.

The "Layers" Menu

Add 2D Text (Cmd-Shift-
L) Add a new layer with a 2D text object at the top of the other layers.

Add 3D Text (Cmd-L) Add a new layer with a 3D text object at the top of the other layers.

Add Shape Activate the Pen tool to start drawing a new shape.

Add Background Add a background image behind the other layers.

Remove Layer Delete the selected layer(s).

Union Merge layers using the Union operation.

Subtract Merge layers using the Subtract operation.

Intersect Merge layers using the Intersect operation.

Exclude Merge layers using the Exclude operation.

Group (Cmd-G) Group selected objects.

Ungroup Cmd-Shift-G Ungroup a selected group.

Split into Letters
(Cmd-Ctrl-Opt-T) Put each character of the selected text layer into a separate layer.

Edit Open a selected image in the vector editor, or open text in the text editor.

Select Next Layer (Opt-]) Select the next layer in front of the current one.
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Select Previous Layer
(Opt-[) Select the next layer behind the current one.

Bring Forward (Cmd-])
Bring to Front (Cmd-
Shift-])
Send Backward (Cmd-[)
Send to Back (Cmd-
Shift-[)

Move the selected object in front of or behind other objects.

Convert to 2D/3D Convert the selected object to the 2D or 3D type.

Enable Geometry
Transformations Enable the possibility to apply the 2D Transformation effect to the object.

Convert to Shape Convert a text object into vector shape(s).

The "Format" Menu

Font > Show/Hide Fonts
(Cmd-T) Open or close the Fonts panel.

Font > Bold (Cmd-B)
Font > Italic (Cmd-I) Modify the properties of the selected text.

Font > Bigger 
Font > Smaller Increase/decrease the size of the selected text.

Font > Kern
Font > Ligature
Font > Baseline

Modify the properties of the selected text.

Text > Align Left (Cmd-{)
Text > Center (Cmd-|)
Text > Align Right
(Cmd-})

Align text to the left, right or center it.

Move to Center
(Horizontally) 
(Cmd-Shift-H)

Center the selected object.
Move to Center
(Vertically)
(Cmd-Shift-V)

Fit to Document Fit the selected object to the document size constraining proportions.

Resize to Document Fit the selected object to the document size without constraining proportions.

Show/Hide Colors 
(Cmd-Shift-C) Display the Colors panel.

The "Window" Menu

Minimize (Cmd-M) Minimize the currently active window.

Zoom Fit the program window to the screen size.

Bring All to Front Show windows of Art Text in front of others.

Design Gallery Show or hide the Design Gallery which gives you access to online resources
and sample designs.
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The "Help" Menu

Art Text Help Open Help documentation delivered with the application.

Tutorials Bring up the collection of video tutorials.

Technical Support… Open the online support form.

Send Feedback… Allows you to send feedback to the developers by email.

Registration… Open the registration form.

Request a Design Set… Send the developer your comments about new design sets that you wish to see
in the app.
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Keyboard Shortcuts
Documents
Windows and Panels
Layers and Objects
Text Editing and Formatting
Vector Editor

Documents

Cmd-S Save the current document.

Cmd-Shift-S Create a copy of the current document.

Cmd-O Open a document.

Cmd-N Create a new document.

Cmd-E Export the current document to a graphic file.

Cmd-W Close the active document window.

Cmd-Q Exit the application.

Cmd-Z Reverse the last operation you performed.

Cmd-Shift-Z Reverse the last Undo operation.

Cmd-= Zoom in the current view.

Cmd-“-” Zoom out the current view.

Cmd-0 Display the actual document size.

Cmd-Y Open the Document Size dialog box.

Windows and Panels

Cmd-“,” Bring up the Preferences dialog.

Cmd-Shift-C Display the Colors pane.

Cmd-M Minimize the currently active window.

Cmd-Ctrl-F Activate or deactivate the full screen mode.

Cmd-Shift-P Open the standard Page Setup dialog for changing the size, orientation and
other parameters of the page.

Cmd-P Bring up the standard Print dialog.
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Layers and Objects

Cmd-Shift-L Add a new 2D layer to the top of the layer stack.

Cmd-L Add a new 3D layer to the top of the layer stack.

Backspace Delete the selected layer.

Cmd-C Copy selected layer(s) into the Clipboard.

Cmd-V Paste the content of the Clipboard into a new layer.

Cmd-X Cut selected layer(s).

Cmd-A Select all layers.

Cmd-D Duplicate the current layer.

Cmd-Shift-H Center the selected object horizontally.

Cmd-Shift-V Center the selected object vertically.

Cmd 
while moving an object Disable the snap function.

Opt-] Select the next layer in front of the current one.

Opt-[ Select the next layer behind the current one.

Cmd-] Bring Forward.

Cmd-Shift-] Bring to Front.

Cmd-[ Send Backward.

Cmd-Shift-[ Send to Back.

Cmd-Ctrl-Opt-T Put each character of the selected text layer into a separate layer.

Text Editing and Formatting

Cmd-V Paste text from the Clipboard into the edit box.

Cmd-A Select all text in the text editor of the Layer Content window.

Cmd-{ Align left.

Cmd-| Center text.

Cmd-} Align right.

Cmd-T Display the Font panel.

Cmd-B Make text bold.

Cmd-I Turn text to italic.

fn fn Dictate your text.

Cmd-Ctrl-Space Open the Emoji & Symbols panel.
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Vector Editor

Opt-L Activate the Straight Segment tool.

Opt-C Activate the Curved Segment tool.

Opt-R Activate the Rectangle tool.

Opt-O Activate the Ellipse tool.

Opt-+ Add a point.

Backspace Remove a point.

Opt-Space Remove all.

Cmd-A Select all.
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Creating, Opening and Saving Documents

Create a New Document

To create a new document, choose File > New from the main menu.

You can also use one of the samples that come together with the program. Those samples can be found in
the Design Gallery and Content Panel. Once you choose a sample, it opens as a new document that you can
edit.

Open a Document

To open an existing document, select File > Open and navigate to your document. Or double-click on this
document in Finder.

In order to open one of the recently edited documents, use the File > Open Recent menu. Alternatively,
search for your document in the Design Gallery. Choose Window > Design Gallery from the main menu and
click on Recent at the top.

Save a Document

To save a document, choose File > Save in the menu.
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Document Settings

To bring up the document settings, choose Edit > Document Size… from the main window.

You can set up a new document size by choosing one of the presets or by inputting the width and height.

The Presets drop-down menu lists popular sizes, for example, YouTube Thumbnail. Presets are followed by
the dimensions that you used recently. Finally, there are two commands. The Clear command clears the list
of recent dimensions. The Crop to Content command makes the document size as small as possible to fit
the design with no margins.

Use the Width and Height fields to set the document size directly. The chain icon to the right lets you
preserve the aspect ratio when you change either width or height. It is possible to change the measurement
units.

By activating the Automatically resize objects option, you allow the program to resize the design when you
change the document size. The aspect ratio of the design will be constrained.

The program uses the last applied width and height as the default size for new documents.
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Introduction to Layers and Objects
Any design on the canvas consists of objects such as images, icons, text and so on. Every object is located
on its own layer since the program allows only one object per layer. So the object and layer terms are mostly
equivalent in this documentation. Adding or removing an object automatically means adding or removing a
layer.

We will say "object" when we explain applying effects. The "layer" term will be used to describe how objects
interact with each other.

There is a list of layers in the Content panel where you can select layers, change their order and perform
some other actions.

Graphic and textual objects in Art Text can be one of two types: 2D and 3D. They have different sets of
properties, and consequently, there are tools which work with only one of these types. In the object's context
menu, you can choose to convert from one type to another. This will enable the tools and settings of the new
type, but the object will lose the effects that you have already applied.
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Object Size, Location and Orientation
To resize or rotate an object, you can use its handles on the canvas. Just drag one of them towards the
direction in which the object should increase or rotate. The handles are displayed when the object is
selected.

To set the object dimensions, coordinates or rotation angle precisely, use the Geometry section in the
Inspector. The size and location are measured in pixels. 2D and 3D objects have identical settings.

Object Size

To resize an object, select it on the canvas and drag its corner or side handle. Make sure that the cursor has
turned into a two-sided straight arrow. To resize without preserving the aspect ratio, drag a corner handle
holding down the Cmd key, or drag a side handle.

The program also lets you set up the object size in relation to the document size.

The Format > Fit to Document menu command resizes an object proportionally so that its bigger size fits
the document.

The Format > Resize to Document menu command works without constraining the proportion.

Object Location

To move an object to another location, drag it with the mouse.

While you are moving an object around, guide lines can appear showing that the object has been aligned to
another object or to the center of the document. The object you move snaps to these positions. You can turn
this feature on and off in the program Preferences. For temporarily disabling the snap function, hold the Cmd
key down while you are moving an object.

You can also center an object in the document by choosing one of the Move to Center commands from the
Format menu.
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Object Orientation

To rotate an object, move the mouse cursor around any corner handle until it turns into a rounded arrow.
Then, drag the handle to the desired direction. To input a numeric value for the rotation angle, use the
Geometry section in the Inspector.

To rotate a 3D object in all dimensions, use the rotation tool located at the bottom of the object in a circle.
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The List of Layers
The list of layers is located in the Content panel. It allows you to access layers disregarding their visibility on
the canvas. You can also change the order of layers, and control some of their properties. The other
properties such as the Opacity or Blend Mode can be found in the Inspector.

1 – Display or hide the layer content.

2 – The layer name.

3 – Lock or unlock a layer. Locking layers prevents them from movement and modification.

4 – Group or ungroup objects. In order to create a group, you must select at least two objects.

5 – Add or remove layers.

6 – Boolean operations: Union, Subtract, Intersect and Join. For details, see Merging Layers.

You can adjust the parameters of several layers simultaneously. To do this, select these layers making sure
that they are of the same type (either 2D or 3D). Then apply the desired effect and set up its parameters. To
select several layers, click on their names holding down the Cmd or Shift key.

Renaming Layers

To change the layer name, double-click on it in the list.

Changing the Layer Order

The order of layer names in the list reflects the layer stacking order in the design. The layer located at the top
of the list is atop the others on the canvas. The layer at the bottom of the list is behind all of the other layers.

To change the stacking order, drag a layer to a new position in the list.
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Adding and Removing Layers

Click the "plus" button to add a new layer.

To create a copy of a selected layer, choose Edit > Duplicate command from the main menu.

Click the "minus" button to remove the selected layer.

Grouping Objects

Select two or more objects that you want to group, and click the Group button at the bottom of the panel.

To ungroup, select the group, and click the Ungroup button at the bottom of the panel.

Nested groups are not supported.

Objects that belong to the same group are marked with the same color at the right side of the list.
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Merging Layers
You can apply Boolean operations to two or more layers in order to create a new combined shape. You can
find out what each operation does below.

1 – Union

2 – Subtract

3 – Intersect

4 – Exclude

To merge layers, select two or more of them and choose one of the layer merging tools.

The configuration of a new shape depends on the size and location of the overlapping areas, but it doesn't
depend on color or gradient fill, texture, shadow or other effects applied to the original objects. If the original
objects are in a vector format, vector paths in these objects will be used. In case of a raster image, the
program will use its rectangular outline as the path. The alpha channel (transparency) will be ignored as well.

The new shape automatically takes properties and effects which were applied to the lowest of the original
layers. After the creation of the new layer, the original ones will be removed. Consequently:

There is no reason to apply effects to upper layers you are going to merge.
If you wish to keep the original layers in your design intact, create copies of them.

Union

The resulting layer shape is the sum of merged layers shapes.
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Original layers:

 

Resulting layer:

Subtract

The shape of the object on the lowest layer is the basis for a new shape. The other objects determine the
area(s) that will be cut off. The result is a part of the lowest object that is not overlaid by other(s). If the
objects don't overlay, the result looks like the lowest object.

Original layers:

 

Resulting layer:

Intersect

The result is the area(s) where all of the selected layers overlap. If there are no such areas, the program
doesn't modify the document.

Original layers:

 

Resulting layer:
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Exclude

If the objects overlay, the overlapping area becomes excluded (transparent). Without overlapping, the result is
similar to the union operation.

Original layers:

 

Resulting layer:
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Splitting Text into Letters
Your design idea may require applying different effects to different parts of text. An effect can be applied only
to the whole text. So, you have to put pieces of text into separate layers to modify them in different ways.

The program can help you create multiple layers out of a single text preserving the position of the letters.
Each letter will be placed on a separate layer. To use this feature, select Layers > Split into Letters in the
menu.

Note that you cannot merge the resulting layers back to create one text layer (except using the Edit > Undo
command). To join letters into a single object, you can use the Layers > Group command.
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The Vector Shape Editor
The built-in vector editor lets you create and modify graphics in the vector format.

To start drawing a new path, click on the plus button below the canvas and choose Shape. You can also
select Layers > Pen Tool Create in the main menu.

In order to edit an object on the canvas, double-click on the object.

While the vector editor is activated, its tools are displayed below the canvas.

1 – The Pen tool is used to add or delete points when you draw or edit a path.

2 – The Move tool lets you move anchor points or adjust their direction lines.
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3 – The Convert Anchor Point tool changes the point type from smooth to corner and vice versa.

4 - Reverse the direction of a selected path. To select the path in the editor, click inside the shape with the
Move tool.

Note that editing the outline of objects of certain type (e.g., 2D objects with a transformation applied, or 3D
objects) takes place in a different editor that opens up in a separate window.

Points and Paths

A vector shape comprises anchor points and lines that connect them. Anchor points mark the beginning and
end of each line (or segment). By adding one line after another, you create a path. The path can be closed.
This means that it begins and ends at the same point.

Anchor points can be of two types: corner point and smooth point. When you change the type of a point,
adjoining lines may change from curved to straight and vice versa.

 

1 – Corner point. At a corner point, a path abruptly changes its direction. A corner point may join either
straight or curved lines in any combination. A corner point with two straight lines doesn't have the direction
lines.

2 – Straight segment.

3 – Smooth point. At a smooth point, a path continues following the same direction. A smooth point joins
only two curved segments.

4 – Direction line.

5 – Direction point. It is a handle on the end of a direction line. Moving a direction point, you can change the
length and angle of the corresponding direction line.

6 – Curved segment.

7 – Corner point.

The direction of a curved path in a smooth anchor point coincides with the direction of the direction line.
Leaving the anchor point, the path branches off from the direction line. The longer the direction line is, the
longer the path that passes near it.
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Drawing a Shape

To draw a shape with straight segments:

1. Click on the plus button below the canvas and select Shape to activate the vector editor.
2. Activate the Pen tool (the editor activates it by default).
3. Click on the canvas to set the first anchor point as the beginning of the path.
4. Click several more times to add as many corners as you need.
5. Make the final click to define the end of the path. In order to make the path closed, click on the first

point. The tool displays a small circle when you move the cursor near the beginning of the path
indicating that clicking at that point will make the path closed.

6. Click on the Done button to close the editor.

To draw a shape with curved segments:

1. Activate the vector editor.
2. Select the Pen tool.
3. Place the cursor where you want to add a new point. Press the left mouse button and move the cursor

to adjust the shape of the path in proximity to the point. Release the mouse button.
4. Add more points as described above.
5. Click on the Done button to close the editor.

There is another way to create a path with curved segments. You can add points for your new shape keeping
all of the segments straight. Then activate the Convert Anchor Point tool and click on points that should be
converted to the smooth point type. Converted points will display their direction lines. Drag the
corresponding direction points with the Move tool to set the curvature and direction of segments. It is
common to use both methods of creating curved segments because it is easier to draw the path roughly and
then adjust points with greater precision.

Images that you create in the editor are solid shapes, not outlines.

The direction that you draw a path matters when you draw one shape over another in a single object, or
when the path crosses itself multiple times. In the picture below, shapes A and B were drawn in the
clockwise direction. C was drawn in the counterclockwise direction. The area where the A and B shapes
overlap remains solid, while the intersection of A and C is a hole.

The vector editor lets you change the direction of a path using the Reverse Path Direction tool.
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Adding Anchor Points

You add anchor points when you draw a path.

To add more anchor points to an existing path, activate the Pen tool and click on a path segment.

Deleting Anchor Points

To delete an anchor point, click on it with the Pen tool. The icon of the Pen tool cursor has a minus sign
when its function switches from adding points to removing them. If the deleted point was in the middle of the
path, the two points before and after the deleted one will be connected with a new segment.

You can also select a point using the Move tool, and then press the Delete button. If the point was in the
middle of the path, a gap will appear in place of the removed point and two segments.

Changing the Type of Anchor Points

To change the type of an anchor point, click on the point with the Convert Anchor Point tool.

Moving Anchor Points

To relocate an anchor point, drag it with the Move tool. A straight segment attached to this point will change
its direction. A curved segment will change the direction and shape.

The Move tool is also used to move the direction points in order to adjust the shape of the path.

The Custom Shapes Library

Objects that you create using the vector editor are stored in your document. You can save a copy of such an
object in the Custom Shapes library to be able to add it to another document. An alternative way to share an
object between documents is to copy and paste it.

The built-in storage for user's shapes is located in the Shapes section of the Content panel. You need to
choose the Custom Shapes category from the drop-down menu.

To add an object to the Custom Shapes library, select this object on the canvas and click the plus button at
the bottom of the library.

To remove an object from the library, click on its icon in the library to select it. Then click the minus button.
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Introduction to 2D Tools and Effects
This section describes tools and effects compatible with 2D type objects.

Originally, a 2D object can be a vector or raster image, or text which is vector by its nature. Effects can also
be divided into vector (e.g., Transformation) and raster ones (e.g., Gradient or 3D Effect). If you activate a
vector effect such as Transformation for a raster image, the program will apply the effect to the rectangular
bound of the image. In the case of a vector content, vector effects work with the shape of letters, icons etc.

By default, all library objects (except for 3D object samples) and images you import are being added to your
project as 2D objects. You can convert a 2D object to the 3D type by right-clicking on it on the canvas and
choosing the Convert to 3D command. You can convert from the 3D to 2D type in the same way. Changing
the object type deactivates all the 2D or 3D effects that you have applied to the object.
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The Text Editor
The program doesn't allow you to edit text directly on the canvas. You should use the text editor. It is located
in the Text section of the Inspector. The 2D and 3D text editors are identical.

The alignment buttons affect the whole text.

The Font button opens the standard Font panel. You can change the font of the whole text or any of its parts.
You should know that the Size controls in the Fonts panel are not intended to adjust the size of a text object
in your document. Use these controls to create different parts of a text with different sizes of letters.

Line spacing can be applied to selected text lines or to the whole text.

Kerning changes the distance between letters of the selected text.

Be careful with fonts that have jagged characters. They usually take longer to render graphic effects. Some of
these fonts can even cause unexpected results when you apply shading or 3D effects.
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The Fill Effect
The Fill tools are located in the Fill section of the Inspector. You can choose to fill an object with a color,
texture or shading effect by clicking on the Color, Texture, Shading or Spray button at the top. The Texture,
Shading and Spray tools are described in separate sections of the documentation.

1 – Turn the Fill effect on or off.

2 – The Plain Color tool.

3 – The Gradient tool. Its settings are located below.

4 – The angle of the gradient effect.

5 – Gradient type: Linear, Radial or Oval. The difference between Radial and Oval gradients is noticeable
when the gradient is applied to a rectangle. The "sphere" created by the gradient is cropped with the Radial
type and deformed with the Oval type.
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Radial gradient:

Oval gradient:

6 and 9 – The basic gradient colors. The circles are handles. To change a color, click on the corresponding
handle. To make one of the basic colors take more space in the object, move the handle towards the middle
of the gradient.

7 – Swap the basic colors.

8 – The middle gradient color. To change the location of the middle color, move the handle towards one of the
basic colors.

10 – The library of pre-designed gradients.

11 – Add or delete intermediate colors. These colors appear between the two basic ones.
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Applying Textures
Art Text can apply textures to text and vector images such as icons or shapes. Applying textures to raster
images usually makes no sense. You can use textures from the built-in library by choosing one of the
categories. It is also possible to import textures from your hard drive by selecting Custom Folder in the list of
categories.

To open the texture library, choose Texture in the Fill section.

To apply a texture, select an object and click on the texture in the library.

The Placement option defines how the texture should fit the object.
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The original object to which a texture will be applied.

The original image used as a texture.

The Fit option matches the texture to the larger shape size. If the texture and object have different aspect
ratios, the texture can be cropped.

The Stretch option deforms the texture to fit the shape.

The Tile option lets you adjust the texture size, angle and position inside the shape. The texture will not be
deformed.
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Scale resizes the texture. The round and square controls let you rotate and move the texture around. These
options are available when the Placement is set to Tile.

The Color button lets you change texture colors. Its effect is a combination of the Hue, Saturation and
Brightness color properties. You can switch the Colors pane to the HSB Sliders mode to be able to adjust the
sliders separately.

The Reset button restores the original texture color.
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Applying Materials
Shading materials are used in Art Text to create 3D looking text and images, to give a glassy, metal, or plastic
look to objects, and for other effects.

To open the shading material library, choose Shading in the Fill section.

To apply the effect, click on a shading material preview in the library, and adjust the properties.

1 - Material categories.

2 - Preview of materials.

3 - Size.

4 - Depth is the amount of the bevel effect.

5 - The angle of the applied effect. For 3D looking objects, this control moves light spots around the center of
the object.

6 - The 3D shape (bevel) selector. It is not available for image-based effects.

7 - The color.

8 - Apply a bump map.
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The program creates the 3D effect using the shader technology when the 3D look is generated based upon
some color and light spot parameters. Alternatively, the effect can be image-based. This means that an
image is used to define light spots and an object's color. Both types of effects are present in the library in
separate categories. The majority of items in the library are shader-based.

Materials are usually applied to vector objects. In this case, the effect is applied to the area inside the
object's outline. If your object is a raster image, the shader will use the transparency to define the amount of
the effect to apply. The more opaque the object parts are, the stronger the 3D effect will be. With no
transparency in a raster image, the effect will be applied to the rectangular bound of a raster image instead of
the image details.

You can customize materials using The Editor of Materials.

Bevel Shape

Dome-shaped

Straight

Concave

Note that straight and concave shapes can produce similar results. They look different with shaders which
have a light spot near the center.
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Light

The Light control moves the light spots around the center. This lets you change the location of a virtual light
source.

When your design consists of several 3D objects, you can adjust the location of light spots as if they
appeared from the same light source.

Depth

At lower values, you will get an object looking almost flat. The slider covers the most appropriate range of
values 1 - 30. To set greater values, use the edit box. Below, you can see circles with the Depth parameter
set to 7, 15 and 30.

At the same Depth value, the result also depends on the size of the object. At some point, increasing Depth
will not change the final image. Small objects can lose a 3D look at values that are too large. This shows how
circles of 50x50, 100x100 and 150x150 pixels look at Depth = 15.
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Color

The Color control changes all colors in a way similar to the Hue parameter in the standard Colors panel.
Black, white and grayscale colors will stay unchanged.

Bump Map

Shaders create smooth surface by default. You can make it uneven using a bump map.

Bump Map is off

 

Bump Map is on

To apply a bump map, just activate the Bump Map option in the Inspector and choose an image to be used
as a bump map.

In order to modify the bump map settings, click on the corresponding gear icon. These settings modify the
image before it is used as the bump map.
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1 - Rotate the bump map.

2 - Offset the bump map in relation to the object.

3 - The library of images that can be used as bump maps. Click on the library to select an image. The drop-
down list of image categories has the Custom Folder… at the bottom. You can use it to access your own
images.

4 - Inverse the bump map. This option turns protruding areas into depressed ones and vice versa.

5 - Change the scale of the bump map.

6 - Adjust the strength of the effect.

7 - Blur the bump map. Adding blur makes elements created by the bump map more smooth.

Pixel Brightness in a Bump Map

You can use a black and white or grayscale image as a bump map. Darker color in the bump map will create
a more depressed area on the object. You can swap the meaning of light and dark colors using the Inverse
checkbox.

Let's see how the brightness of different parts of the bump map affects the final design. We can take a funny
medal as an example.

The bump map (created outside Art Text) has a kind of staircase below the "1". This staircase is actually the
key part of the example. Let's take the body of the medal as the base level. Now, we are going to make three
stairs on the left depressed, while the other three should look protruding. This effect can be achieved by
making the depressed elements darker than the body. The protruding elements should be lighter than the
body.

See how the same elements look in the bump map and design.

Bump Map

 

Medal created using a bump map
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The Editor of Materials
The material editor can be accessed through the material library by choosing Shading in the Fill section. You
can either create a new material or customize one of the materials in the library.

To create a new material, select Create a Material… in the drop-down list of categories.

To edit a standard or custom material, double-click on its preview. Customized and new materials will be
saved in the Custom Materials category.

The window of the material editor shows a list of custom materials in the left panel. Buttons below the list let
you add, remove and make a copy of the selected material. The middle part of the window shows
parameters of the selected material. Samples of an applied material are displayed on the right.

The material editor lets you create materials based on shaders and based on images.
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Materials Based on Shaders

The main properties of a shader-based material are the Ambient, Diffuse and Specular colors and adjustable
light sources.

The Ambient, Diffuse and Specular colors define how an object's parts look under different types of lighting.
The Ambient color is the object's color in a deep shadow. The Diffuse color is the object's color in poorly
dissipated white light. It's usually the natural color of the object. Finally, the Specular color lets you simulate a
reflection from a light source directed to the object. One specular light source is always present (let's call it
the "main" one). If necessary, you can add more.

Parameters of Light Sources

The position of each light source is displayed on the sphere as a white circle if the light is on, and a black
circle if the light is off. You can move light sources by dragging the corresponding circles. If there are no
circles on the sphere, select the Show spotlight controls checkbox. The main light source can also be
relocated using the Azimuth and Elevation controls.

Spot Size defines the size of the reflection. Using this parameter, you can make the light be more or less
directed.

Shininess blurs the light spot, making its edge more or less sharp.

Together, Spot Size and Shininess let you make the object look matte or glossy. As a rule, a reflex from the
same light source is big and blurred on a matte object, and small and sharp on a glossy object.

Border controls how quickly the light fades near the edge of the light spot.

Materials Based on Images

Using images, you can create materials similar to shading materials or something completely different. An
image will be mapped on the object's surface. There are no settings for image-based materials except for the
possibility of rotating them.

To create a new material, click the Create from Image button and choose a graphic file. Any further
adjustments can be made in the main window.
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The Spray Effect

The Spray tool can fill the given area with numerous copies (or variations) of small images. We will call such
an individual image "item". The covered area is basically defined by the object's outline.

Unlike filling an object with a texture, Spray won't create any visible pattern. The created effect will look
random. You can customize the set of items used in the effect, how they look, and how many of them should
appear in the artwork.

To apply and customize the Spray effect, open the Fill section of the Inspector, and choose Spray.

Changing the settings in the Inspector will not affect presets in the library.
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1 - The set of items used in the currently selected preset.

2 - Open the popup menu with presets.

3 - Add or delete an item from the current set.

4 - The density of items on the object. You can opt to have gaps between items, or to make them overlap
leaving no gaps.

5 - The size of items. If items have different sizes (see Size in the Randomize section), this control defines the
maximum size.

6 - Rotate all of the items by the same angle. This angle will serve as the median if the Angle slider in the
Randomize section is not in the leftmost position.

7 - Define the randomness of the items' location. The far left state of this control places items in rows and
columns. The farther to the right you move the slider, the more random location items will have.

8 - Apply random sizes to different items. Items will have the same size at the far left position of the slider. If
you move the slider to the right, some items will decrease in size.

9 - Rotate items by random angles. Items will have the same orientation at the far left position of the slider. If
you move the slider to the right, items will get random positive or negative deviations from the original angle.
The position of the slider will define the maximum deviation angle.
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10 - Align items to object normals. See Align to Normals for more details.

11 - Activate the light effect. See Light for more details.

12 - Activate the shadow effect. See Shadow for more details.

13 - Apply the distribution map. See Distribution Map for more details.

14 - Apply the Colorize effect.

Presets

A preset stores information about items used in the Spray effect and settings of the effect.

To choose a preset, click the Preset button, and then click on a thumbnail in the list.

The program has a number of default presets and a library of items. Items, such as coffee beans, leaves and
so on, are grouped into categories. The default presets are created using items from the library. Some of the
presets use all of the items from the corresponding category, others use only a part of the available items.

The library indicates items that are already present in the preset by blue frames.

Once a preset is loaded, you can change its settings, and also edit the set of items in it.

Notice that any of your modifications will not affect the default presets. So, you can freely experiment with
them. It will be easy to get back to your starting point by choosing the same preset again.
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Adding and Deleting Items from the Set

To delete a particular item from the set, click on that item to select it. Then click the minus button.

To add an item to the set from the library, click the plus button. Then open a category and click on each item
you want to add.

Notice that you can select Custom Folder… in the list of categories, and import your own images.

Creating Your Own Preset

Once you have changed the set of items as described above, you may want to save it for later use.

To save the current preset, click the Preset button in the Inspector. At the top of the preset library, choose
Custom Folder from the pop-up menu. Finally, click the plus button at the bottom.

In order to delete a custom preset, select it in the list and click the minus button.

Align to Normals

The Align to Normals check box lets you choose an alternative way to set angles of items in your artwork.
To see the maximum effect of this option, you should turn off the randomization of the angle (move the Angle
slider in the Randomize section all the way to the left). Also, the items should be thin and long.

When Align to Normals is activated, the items become oriented off the middle towards outside the object.
They may resemble cactus spines or fur.
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The orientation of items is defined by the Angle

 

Items are aligned to normals

Note that actual graphics in the images can have a certain rotation angle by default. For instance, most of the
leaves in the library are rotated by about 45 degrees. This means that you may need to adjust the Angle after
enabling Align to Normals.

You can also adjust the angle in order to make items follow the direction of the object's outline. The images
below show how different the results might be.
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Leaves are across the object's edge—it's not easy to see the "e"

 
Leaves are along the object's edge—the letter is more readable

Light

The Light option can improve the 3D look of items. It adds a reflex with the possibility to adjust its position
and other properties. Compare the images below.
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The Light option is deactivated

 

The Light option is activated

Notice that some images in the library have a reflex and shadow. Consequently, there is no need to activate
the Light and Shadow options for them.
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Settings of the Light Option

To show the settings, click on the corresponding gear icon.

The Amount parameter lets you adjust how strong the effect is.

The Glossiness slider changes the size of the reflex. Glossier objects have smaller but brighter reflexes.

The Direction control moves the reflex around changing the position of an imaginary light source.

The Ambient color defines the object's color in the deep shadow. It can be dark gray.

The Diffuse color defines the object's color under diffuse light. In many cases, it coincides with the natural
color of the object.

The Specular color is used to create a reflex. To adjust its size, use the Glossiness slider.

Shadow

The Shadow option creates a drop shadow for each item.

For a stronger 3D effect, it is better to use the Shadow together with the Light option. In such a case, make
sure that the angles of Shadow and Light are set properly. The reflex and shadow should appear
approximately on opposite sides of the item.

Settings of the Shadow Option

To show the settings, click on the corresponding gear icon.

The Blur parameter defines the density of the drop shadow.

The Distance parameter defines the offset between the object and shadow which visually looks like the
distance between the object and surface behind it.

The angle of the shadow changes the location of the virtual light source.

The round control lets you adjust the Distance and Angle at once. Drag the handle off the center.
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The Color parameter gives you an option to make the shadow other than gray.

Distribution Map

The Distribution Map option reduces the randomness of how items of different types are located.

In the image below, we can see distinctive areas taken by balls of each color.

Items of the same type are located according to two factors. These are the order of items in the Inspector,
and the settings that define the mapping principle.

In our example, the order of balls in the Inspector is the following: blue, yellow, red, and green.

The image that defines the areas to be taken by the balls of each color consists of grayscale zones.
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The Distribution Map option associates, or maps, each color to its own zone. The first ball in the list (blue)
goes to the darkest zone. The following yellow color takes the second darkest area, and so on.

The order of items in the Inspector is simply the order they were added to the list. So, to reorder items, you
need to remove them, and then add them in the desired order.

Settings of the Distribution Map

To show the settings, click on the corresponding gear icon in the Inspector.

There are two major mapping options: Height Map and Texture.

The effect from using the Height Map resembles a circular gradient. The first item becomes distributed along
the object's edge in the shape of a ring. The second item creates a smaller ring, and so on. The middle of the
object is taken by the last item in the list.
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The Scale parameter is used to change the amount of space taken by the items.

The Position control lets you move the structure off the object's center.

You can also map items to an image by selecting the Texture option. How this type of mapping works was
discussed in the beginning of the Distribution Map section. We mapped items to a custom image, but you
can also use textures from the built-in library.

In order to choose a new texture, click on the thumbnail of the current texture. The library will open up. The
drop-down menu lets you select a category of textures. You can also click on Custom Folder… to select a
graphic file for your texture.

The circular control to the right from the thumbnail is used to rotate the texture.

The square control defines the offset of the texture in relation to the object's center.

Using the Placement drop-down menu, you can select how the texture should fit the object. Imagine that the
object in your document is of a rectangular shape, but the texture is a square. Since one doesn't fit the other
exactly, you can select Stretch and allow the texture to be deformed. Or, you can choose Tile to preserve the
aspect ratio of the texture, but allow tiling.

The Scale slider works only when Tile is selected. This slider changes the size of the texture so that you can
fit one or multiple copies of the texture to the object.

Colorize

The Colorize tool lets you create an effect that resembles a mosaic. The tool tints items (e.g, Lego blocks) in
colors that are present in a selected image. This tool differs from the Distribution Map. While the Distribution
Map rearranges the colors of the given items, Colorize applies new colors. This is why even one item will be
enough to create a colorful moraic.
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In order to create a mosaic, prepare an image that you want to recreate. Find out the aspect ratio of its sides.
Add a rectangle or other shape to your document. You can find one in the library of Smart Shapes. Choose
an item. Set the aspect ratio of the shape the same as the image has. It is recommended that you start with
Lego blocks as they give the most predictable result. Set the Density and Size to smaller values. Set all of
the Randomize options to minimum. Then activate the Colorize effect. Open its settings and click on the
image box. Select the image that you have prepared. Adjust other effect settings if needed. You may also
need to adjust the Density and Size properties.

The Colorize tool works best with images that don't have too many thin lines or small details.

The color and especially brightness of items affect the final image. It will be easier to start your design with a
single item. Then you can experiment with adding more items of different colors.

Settings of the Colorize Effect

To bring up the settings, click on the gear icon.

The image box lets you choose an image from the internal library or load a custom one. The image will fill a
currently selected object according to the Placement option. Fit places the image so that its aspect ratio is
preserved. The image will be cropped if its aspect ratio differs from the shape's aspect ratio. With Stretch,
the image will fit the shape entirely but it can be distorted. The Tile mode lets you tile the image.
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The square control lets you offset the image in relation to the shape. It is enabled only for the Tile mode. For
greater precision, use the X and Y fields.

The Scale changes the size of copies of the image when it is tiled.

The round control lets you rotate the image in relation to the shape. It is enabled only for the Tile mode. You
can also enter the angle into the field below.

The Brightness and Contrast sliders affect the selected image before it is further used for the effect. They
may be helpful in emphasizing details.
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Applying Stroke
You can outline text and vector shapes by adding a stroke. If you apply this effect to a raster image, its
rectangular edge will become outlined.

The Stroke tool is located in the Effects section of the Inspector.

In order to modify the stroke settings, click on the corresponding gear icon.

1 – Stroke color.

2 and 3 – Add and Remove strokes.

4 and 5 – The stroke width.
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You can add multiple lines with different widths and colors.

If spaces between letters are too small after adding strokes, increase the Kerning parameter in the Text
section of the Inspector.
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The Shadow Effect
The Shadow tool is located in the Effects section of the Inspector.

In order to modify the shadow effect settings, click on the corresponding gear icon.

The Blur parameter defines the density of the drop shadow.

The Distance parameter defines the offset between the object and shadow which visually looks like the
distance between the object and surface behind it.

The angle of the shadow changes the location of the virtual light source.

The round control near Distance and Angle lets you adjust these two parameters at once. Drag the handle
off the center.

The Color property just gives you an option to make the shadow other than gray.
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The Glow Effect

The Glow tool is located in the Effects section of the Inspector.

In order to modify the glow effect settings, click on the corresponding gear icon.

The Size parameter defines the width of the glow.

The Spread parameter defines the amount of the non-transparent area within the width of the glow.

The glow effect lets you set up one or two colors. When the Tint color is enabled, a second color outlines the
main glow. In the picture below, 1 is the main color and 2 is the tint color.

The Blend Mode options define how the glow effect should interact with colors of underlying objects.
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The Inner Shadow Effect

The Inner Shadow tool is located in the Effects section of the Inspector.

In order to modify the inner shadow effect settings, click on the corresponding gear icon.

The Size parameter defines the width of the inner shadow.

The Spread parameter defines the amount of the non-transparent area within the width of the inner shadow.

The Color property lets you change the color and transparency of the shadow.

The Distance parameter defines the offset between the object and inner shadow.

The Blend Mode option defines how the colors of the object and inner shadow interact with each other. The
Normal option works well with most combinations of the object and inner shadow colors. Multiply takes
effect when the shadow is darker than the object. Use Screen when the object is darker than the shadow.

One of possible uses of the Inner Shadow tool is to create the concave surface effect.
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Applying Masks
The Mask effect creates transparent areas on an object. Masks can be used to make a part of an object
invisible, or create effects like cracks or stains, or to combine several objects.

To apply a mask, use the Mask section in the Inspector.

Masks in the library are black and white images. Black areas in a mask create transparent areas on an object.

1 – The library of masks. Click on it to bring up the list of masks.

2 – The offset of the mask in relation to the object.

3 – The rotation angle.

4 – Inverse of the mask.

5 – The scale of the mask. The mask will be tiled if you make it smaller than the object.

6 – The brightness of the mask. This parameter makes the whole object more or less opaque.
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7 – The contrast of the mask.

The Brightness and Contrast parameters are helpful when you use a colored image as a mask. In this case,
these two parameters let you set up the threshold between the transparent and opaque areas.

The program applies a mask to your object after applying other effects such as transformation. This means
that if you distort an object, the mask will not be affected.
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Transformations
Transformation effects create geometric distortion of text or vector images (such as shapes or icons from the
internal library). Transformations cannot deform raster images. If you transform a vector shape with an
applied texture, the texture will not be deformed.

The Transformation tools are located in the Geometry section of the Inspector.

To transform an object, click on the Transform box to bring up the list of transformation effects. Then click
on a transformation to apply it. Finally, adjust the distortion using a slider below the list.

Note that some objects have the Transformation tools disabled by default. To enable the tools, bring up the
context menu and select Enable Geometry Transformations. The same command can be found in the
Layers menu.

To restore the default state of an object, click the Reset button.

When several objects are selected, you can use only geometric transformations.

There are Geometric transformations which are based on patterns, and Spline transformations which distort
objects along curves. Icons of spline transformations in the list have small circles.



97

Geometric Transformations

Geometric transformations are located at the top of the list.

Each transformation has one or two parameters. To adjust them, use the sliders below the list.

Spline Transformations

Spline transformations are primarily intended to distort text. Text goes along a spline which is straight by
default. To distort it, you should curve the spline by dragging its handles on the canvas.

Note that the Curved Text transformation makes no change to a single letter or an image. You should apply it
to at least several letters.
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Distortion Effects
Distortion effects belong to a special class of effects that modify the contour of the object before other
effects are applied. The contour here is defined as the visible edge of the object. In other words, it is where
pixels of the object's body end and transparency begins. Some of the distortion effects also create new holes
in the object.

These effects are intended to work with the object's shape. It might be useful to set up the distortion effects
while an object has only plain color fill and no other effects applied. All of the distortion effects have
something in common with masks. They manipulate the transparency of an object's pixels without affecting
the colors.

You can combine multiple distortion effects to achieve unique results. A set of effects can even include the
same type of effect with different settings.

The Distortion effects are located in the Effects tab of the Inspector.
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By default, the list of the distortion effects is empty. You apply effects to an object by adding them to the list.

To apply a Distortion effect, click the plus button right below the list and choose one of the effects. You can
add the same effect multiple times.

You can use your own effects in the program. The plus button lets you choose the Custom option in order to
select a distortion effect saved as a *.qtz (Quartz Composition) file. Quartz Compositions can be created in
the Quartz Composer.app. For more details, please contact Technical Support.

In order to deactivate an effect, click on its name in the list. Then click the minus button.

To deactivate an effect without removing it, use the check box near its name. This makes sense if you want to
keep an already made setting in order to re-apply the effect to the same object later.

To set up the effect, click on the corresponding gear icon.

The Order of Effects

The order of effects in the list can significantly impact the result. The effect at the top of the list is applied
first.

To change the order of effects, drag an effect to a new position in the list.

In order to illustrate why the order is important, we can apply two effects to a shape.
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The original shape

First, let's see how each of the effects works independently.

Displacement
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Erosion

In the next image, Displacement was applied first. It made the edge of the shape jagged. Then Erosion
created holes in the object and additionally affected the external edge.

Displacement applied before Erosion

Here, we changed the order of the effects. Erosion was applied first, creating holes in the object. The external
edge was changed insignificantly. Displacement, applied after that, made edges jagged again. This time, it
jagged not only external edges but also edges of holes.
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Erosion applied before Displacement



103

The Displacement Effect
The Displacement effect might resemble you looking at an object through a frosted glass. Patterns for the
Displacement effect are based on textures. This effect is one of the Distortion effects.

To apply the Displacement effect, open the Effects section in the Inspector. Then, click the plus button and
select Displacement.

In order to modify the effect settings, click on the corresponding gear icon.
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1 - Rotate the texture.

2 - Offset the texture in relation to the object.

3 - The library of textures. Click on it to select a different texture.

4 - Inverse the texture.

5 - Change the scale of the texture.

6 - Change how much the object should be distorted.

7 - Decreasing this parameter decreases the amount of texture details that are used for distortion.
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The Side Displacement Effect
The Side Displacement effect is similar to the Displacement effect. The difference is that with Side
Displacement, the object becomes distorted on a specified side. Patterns for the Side Displacement effect
are based on textures. This effect is one of the Distortion effects.

To apply the Side Displacement effect, open the Effects section in the Inspector. Then, click the plus button
and select Side Displacement.

In order to modify the effect settings, click on the corresponding gear icon.
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1 - Rotate the texture.

2 - Offset the texture in relation to the object.

3 - The library of textures. Click on it to select a different texture.

4 - Inverse the texture.

5 - Change the scale of the texture.

6 - Change the direction from which the distortion should be applied to the object.

7 and 8 - Adjust how much of the object's body should be distorted.

9 - Increasing this parameter spreads the distortion over the whole object's perimeter. In other words, larger
distortion on a particular object side gradually turns into smaller distortion applied to all sides.

10 - Decreasing this parameter decreases the amount of texture details that are used for distortion.
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The Roundness Effect
The Roundness effect makes all object's corners rounded. This effect is one of the Distortion effects.

To make the object's corners rounded, open the Effects section in the Inspector. Then, click the plus button
and select Roundness.

In order to modify the effect settings, click on the corresponding gear icon.
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Roundness changes the diameter of a rounded corner. The smaller the value, the sharper the corner.

The Offset parameter defines how much bigger the rounded object can become in comparison with the
original. The following image displays two rounded objects that were placed one over another. They have all
other parameters equal except for the Offset. The yellow arrow has a smaller Offset, and consequently, it is
smaller than the blue arrow.

The Sharpness parameter makes the outline of the object a bit blurry when you decrease its value.
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The Brush Effect
The Brush effect makes objects look like 3D. The result is similar to applying shading materials. Patterns for
the Brush effect are based on textures. This effect is one of the Distortion effects.

To apply the Brush, open the Effects section in the Inspector. Then, click the plus button and select Brush.

In order to modify the effect settings, click on the corresponding gear icon.
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1 - Rotate the texture.

2 - The library of textures. Click on it to select a different texture.

3 - Inverse the texture.

4 - Change the scale of the texture.

5 - Change the brightness of the texture.

6 - Change the contrast of the texture.
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The Outer Defects Effect
The Outer Defects effect mostly affects the area around the object. Depending on the settings, the outline of
letters might be preserved keeping text well readable. Patterns for the Outer Defects effect are based on
textures. This effect is one of the Distortion effects.

To apply the Outer Defects effect, open the Effects section in the Inspector. Then, click the plus button and
select Outer Defects.

In order to modify the effect settings, click on the corresponding gear icon.
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1 - Rotate the texture.

2 - Offset the texture in relation to the object.

3 - The library of textures. Click on it to select a different texture.

4 - Inverse the texture.

5 - Change the scale of the texture.

6 - Change the density of the texture "particles". You can make them bigger or smaller.

7 and 8 - Adjust how much space around the object should be taken by the effect.

9 - Decreasing this parameter decreases the amount of texture details that are used for distortion.
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The Erosion Effect
The Erosion effect makes object parts transparent similarly to a mask. Using specialized settings, you can
tweak the output of Erosion in a distinguishably different manner than you can do with Mask. Patterns for the
Erosion effect are based on textures. This effect is one of the Distortion effects.

To apply the Erosion effect, open the Effects section in the Inspector. Then, click the plus button and select
Erosion.

In order to modify the effect settings, click on the corresponding gear icon.
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1 - Rotate the texture.

2 - Offset the texture in relation to the object.

3 - The library of textures. Click on it to select a different texture.

4 - Inverse the texture.

5 - Change the scale of the texture.

6 and 7 - Change how much of the object's body should be eroded.

8 - Make the object corners rounded. Increasing this parameter makes the object's contour have less detail.

9 - Apply the effect to the inner rather to the outer part of the object.

Compare two squares with different states of the Inner checkbox.

Inner option is off

 

Inner option is on
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The Mask Effect
The Mask effect lets you apply a mask to an object. This effect is one of the Distortion effects. There is
another tool in the program that also helps you apply a mask.

To apply a mask, open the Effects section in the Inspector. Then, click the plus button and select Mask.

In order to modify the effect settings, click on the corresponding gear icon.
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1 - Rotate the mask.

2 - Offset the mask in relation to the object.

3 - The library of masks. Click on it to select a different mask.

4 - Inverse the mask.

5 - The scale of the mask. The mask will be tiled if you make it smaller than the object.

6 - The threshold level. When the mask has different levels of the gray color, you can choose from which
point certain tints of gray should create transparent areas.

7 - The contrast of the mask. It is useful when you have gray areas in the mask.

8 - Blur the mask. Increasing this parameter decreases the amount of details in the mask.
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The Blur Effect
The Blur effect helps you blur the whole object or its parts. The areas to be blurred are defined by a texture.
This effect is one of the Distortion effects.

One of the uses of this effect is to create an illusion that some spots in a watercolor picture were washed out.

To apply the Blur effect, open the Effects section in the Inspector. Then, click the plus button and select Blur.

In order to modify the effect settings, click on the corresponding gear icon.
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1 - Rotate the texture.

2 - Offset the texture in relation to the object.

3 - The library of textures. Click on it to select a different texture.

4 - Inverse the texture.

5 - Change the scale of the texture.

6 - Change the contrast of the texture.

7 - Decreasing this parameter decreases the amount of details in the texture. The texture itself becomes
more blurry.
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Introduction to 3D Tools and Effects
This section describes tools and effects compatible with 3D type objects.

The 3D tools can be effectively used only with text and vector objects. Any raster image turned into a 3D
object will look the same way, like a rectangular prism.

When a 3D object is selected, it has a 3D rotation tool on the canvas in addition to regular resize and rotation
handles. To rotate the object, move the 3D rotation tool around.

You can convert a 2D object to the 3D type by right-clicking on it on the canvas and choosing the Convert to
3D command. In the same way, you can convert from the 3D to 2D type. Changing the object type
deactivates all the 2D or 3D effects that you have applied to the object.
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The Text Editor
The program doesn't allow you to edit text directly on the canvas. You should use the text editor. It is located
in the Text section of the Inspector. The 2D and 3D text editors are identical.

The alignment buttons affect the whole text.

The Font button opens the standard Fonts panel. You can change the font of the whole text or any of its
parts. You should know that the Size controls in the Fonts panel are not intended to adjust the size of a text
object in your document. Use these controls to create different parts of a text with different sizes of letters.

Line spacing can be applied to selected text lines or to the entire text.

Kerning changes the distance between letters of the selected text.

Be careful with fonts with jagged characters. They usually take longer to render graphic effects. Some of
these fonts can even cause unexpected results when you apply shading or 3D effects.
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Applying Materials
The program has a library of pre-designed materials. It lets you apply materials in a few clicks. Additionally,
you can customize any of the library materials.

To apply a material, click the Preset button near the Material section title. Then choose one of the categories
and click on a material.
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Creating Materials
To create a new material, you can modify a default one. If any of the library materials is similar to what you
want to create, start from this predesigned material.

To adjust the material properties, open the Material section in the Inspector.

Texture

To open the texture library, click on the preview of the current texture. In the texture library, you can choose
textures from one of several categories, or select a plain color at the top of the library.

The Color button at the top right corner lets you change texture colors. Its effect is a combination of the Hue,
Saturation and Brightness color properties. You can switch the Colors pane to the HSB Sliders mode to be
able to adjust the sliders separately.
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The round and square controls in the middle change the angle and offset of the texture.

Scale lets you magnify the texture.

Material Finish and Colors

This group of material properties is responsible for how lighting affects the object. You should adjust the
parameters below together with the light sources.

Ambient, Diffuse and Specular colors let you adjust the look of shadowed and lit parts of the object. It is
easier to learn how these colors appear on the object when only one light source is on, a plain color is used
as a texture and the Bump Map and Environment Texture tools are deactivated.

Ambient is the object's color when there is no light at all. It can be black, or more often a darker version of
the Diffuse color.

Diffuse is the object's color under diffuse light. In many cases, it coincides with the natural color of the
object.

The Specular color is used to create a reflection of a direct light source. The more matt the object is, the
bigger and less sharp the light spot is. To control this, use the Glossiness slider.

The following image shows spots on the object where the Ambient, Diffuse and Specular colors are
dominant. These colors interact with each other, texture and also with applied effects. Due to this, you can
see spots of pure Ambient, Diffuse and Specular colors not so often.
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Glossiness makes the object look more or less glossy.

Bump Map

The Bump Map tool adds more volume to the texture details.

Object has no Bump Map

 

Object with Bump Map

In order to select a new bump map or adjust the settings, click the corresponding gear icon.

Strength controls the amount of roughness created by the tool.

Smooth makes the effect smooth by hiding smaller details.

The Scale slider lets you resize the bump map if you need to match its scale to the texture or to the object's
size.

If you are using a texture from the built-in library, the program automatically finds the corresponding bump
map in the library. To select a different bump map, choose one in the Bump Map settings. You need to click
on the preview of the current bump map to bring up the library.
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The library contains bump maps created specially for built-in textures. These bump maps add extra details to
the object surface.

Object with specialized bump map

You can select one of the provided bump maps or import one from a graphic file. To do that, open the drop-
down menu and choose Custom Folder…

There are two options at the top of the library: Height Map and Normal Map. They are used to specify the
type of a bump map that was imported. If your bump map is a black and white image, then it is likely to be of
the Height Map type. A Normal Map is usually a violet image with green and red areas. The screenshot of the
library above displays examples of the Normal Map type.
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Reflection Mask

Reflection masks are used to remove patches of light on the object surface. This might be useful when your
3D object should look matt.

The letter in the example below is partially covered by rust. The remains of the paint can be a bit glossy, but
the rust cannot. In order to tell the program which areas shouldn't be reflective, we apply a reflection mask.

Object without reflection mask

 

Object with reflection mask

In order to change the reflection mask, click the corresponding gear icon.

If you are going to create your own reflection mask, use dark colors or black in the mask for areas where
reflection should be masked.

Environment Texture

The Environment Texture tool extends the lighting effect created by the Light Sources properties. By
applying an environment texture, you can simulate reflexes from particular light sources such as windows.

The Color button works the same way as the one in the Texture section.

A round control rotates the texture.

The Opacity parameter changes the amount of the effect applied to the object. This is useful when you need
to mix the Environment Texture effect with others.
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Smooth is intended to make the object matt or glossy. When you move the slider to the right, the object
becomes matt.

The Blend Mode defines how the colors of the main and environment textures mix with colors of other
effects.

Light Sources

The program lets you set up four light sources. In the preview, each of them is presented as a circle on a
sphere. A blue circle means that the light is turned on, and a gray one indicates that the light is off. Smaller
circles show the location of light sources behind the sphere.

If a light source is on, it casts light on the sphere.

You can choose the light source color in the box below the sphere.

The Shadow option allows object parts to cast shadows on the object itself. Unlike the Shadow effect in the
Effects section, this option has no connection to the shadow that is cast on the background or other objects.

Saving Custom Materials

As soon as you are happy with the customized material, you can save it in the Custom category of the
material library. To do this, select an object with that material applied, click the Preset button, and then click
on plus at the bottom of the material library.

To rename a custom material, double-click on its name.

To delete a custom material, select it in the library and click on minus.
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The Shadow Effect

To access the Shadow tool, open the Effects section in the Inspector.

The Position lets you move the shadow around by changing the direction and how far the shadow spreads
from the object. By dragging the handle, you change the location of a virtual light source.

The Attenuation parameter varies how quickly the shadow fades out.

Blur makes the shadow more or less soft.

The Color button lets you change the color of the shadow.
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The Depth Gradient Effect

To access the Depth Gradient tool, open the Effects section in the Inspector.

The Depth Gradient effect is intended to apply a gradient or solid color to the 3D object sides. This effect can
be used to emphasize the transition from the lit up to shadowed object parts.

In order to open the gradient panel and set up the colors, click on the gradient icon. The gradient panel
controls are described in the The Fill Effect section.

The Overlay option applies the Depth Gradient effect over other effects located in the Material tab.

The Blend Mode options define how to mix the gradient colors with colors produced by other effects.

By changing the Opacity, you can make the effect more or less strong.

If you swap the positions of the dark and light colors in the default gradient, you can create the backlight
effect.
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The Glow Effect

To access the Glow tool, open the Effects section in the Inspector.

The Brightness parameter controls the amount of glow, mostly considering the position of the object in
relation to light sources. In the picture below, the glow is only around the letter "S" because it is turned to the
light source the most (due to transformation and 3D rotation).

 

Increasing Brightness makes the effect spread over the other letters.

 

Blur makes the glow more or less soft, and consequently take more or less space around the object.

Opacity lets you control the amount of the effect but in a way that is different from Brightness. Here, you
make the whole glow more or less strong through its transparency.

 

The Glow effect looks best with dark backgrounds.

The Glow effect highlights only the bright parts of an object. This makes it different from the 2D Glow which
appears around the whole object.



131

Glow is off:

Glow is on:
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The Focus Effect

To access the Focus tool, open the Effects section in the Inspector.

The Focus effect has two settings Length and Blur.

The Focal Length parameter defines the distance to the point in focus.

Blur controls how blurred the object's parts which are not in focus will be.

The Focus effect works well if an object is rotated horizontally using the 3D rotation tool as the object was in
perspective.
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Applying Masks
To apply a mask to a 3D object, use the Mask section in the Inspector. The effect has exactly the same set of
properties as the 2D mask.

The program applies a mask to your object after applying other effects such as transformation or 3D rotation.
This means that if you distort an object, the mask will not be affected.

In order to achieve interesting effects, you can combine a masked layer with another layer in the background
and have the gaps filled with some color.
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Transformations
Transformation effects create geometric distortion of 3D objects. These tools are located in the Geometry
section of the Inspector.

 

To transform an object, click on the Transform box to bring up the list of transformations. Then click on a
transformation to apply it. Finally, adjust the distortion using the sliders below the list.

To restore the default state of an object, click the Reset button.

You can transform several selected 3D objects at the same time.
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The 3D Object Settings
To access the 3D object settings, open the Geometry section in the Inspector. These parameters let you
control the basic 3D object appearance.

We are going to learn about the Depth, Thickness and Chamfer in this section. The rest of the settings are
described in the dedicated sections.

The Depth parameter makes the object more or less flat.

Thickness makes the object's parts thicker. With text, it may look as if you made it bold. Solid objects such
as bricks just become slightly bigger.
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Chamfer can make the object's edge rounded or sharp. You can also choose the shape of the chamfer.
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The Projection Effect

The Projection parameter defines how an object should look after the 3D rotation was applied to it. You can
find this parameter in the Geometry section of the Inspector.

Let's take a look at a series of the "I" letters converted to a 3D object. Originally, all of them have the same
height.

When you apply the 3D rotation to an object, the program displays it in perspective by default. To show the
increasing distance to letters at the end of the text, the letters gradually become smaller. This makes the
impression that the text is three-dimensional even stronger.

Using the Projection slider, you can change the strength of the effect. While you are moving the slider from
the left to the right, the difference between the biggest and smallest letters will decrease.

If you are going to create a title for a website or printable document, you may want all letters to have the
same height. To do this, activate the Parallel Projection option in the Geometry section of the Inspector.
Alternatively, you can drag the Projection slider to the rightmost position.
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The Projection effect is intended to be applied to short pieces of text that have multiple letters. Applying the
effect to a shape or to an individual letter is possible, but the result would look more like a deformation.
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Exporting
You can export your design to a graphic file or copy it to the Clipboard.

To export your document to a graphic file:

1. Select File > Export in the main menu, or click the Export button at the bottom right corner of the
canvas and choose File…

2. Type a file name and choose a destination folder.
3. Select an image format in the Format drop-down list.
4. Set up the available settings.
5. Click the Save button.

Exporting Layers Separately

You can export your design so that each layer will be saved as an individual file. This can be helpful if you
want to edit or combine those layers using some other application. To do this, activate the Export Layers to
Individual Files option.

Exporting to the Clipboard

To copy your design to the Clipboard, click the Export button at the bottom of the canvas and choose
Clipboard.

Your design will be exported in the PDF format. In the program Preferences, you can set up the image
resolution for raster graphics to be copied to the Clipboard.

Sharing

Upon clicking the Export button below the canvas, you can find several sharing options. Instead of saving
the design on the hard drive, it will be sent to a particular application or service. This function requires that
you have installed and set up the respective application. Or, you should create a user account for the
respective service and have your computer connected to the Internet.
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Exporting your Design with a Depth Map
A depth map lets you create an illusion of a 3D image while your original image is a regular 2D picture. In
order to simulate the third dimension, a depth map is used. It stores information about the distance from the
viewer to different objects on the 2D picture. You could see 3D photos, created with this technique, on
Facebook.

A specialized image viewer is needed to see the 3D effect. It must be able to open the picture and depth map
together. The viewer presents the 3D effect as the possibility to slightly change the point of view by moving
the mouse pointer over the picture, or in some other way.

When you export a 3D Photo, the program creates a folder with two files: your design and a depth map. Both
of them are needed for the 3D photo effect.

What is a Depth Map

A depth map is a grayscale image where the brightness encodes the relative distance to an object in the
picture. The darker the color is, the farther the object. Some viewers may require the opposite use of the
brightness.

So, a depth map usually looks like contours of main parts of the picture filled with grayscale gradients, or
grayscale plain colors.

Requirements to a depth map may vary depending on where you want to preview your images. Typically,
these requirements apply:

The original image and the depth map should have the same aspect ratio.
Image format should be PNG or JPEG.
Facebook also expects that the name of the depth map file is composed of two parts: the image name
followed by "_depth". For example, if the image is named "forest.jpg", the depth map would be
"forest_depth.jpg".

The Export Depth Map dialog will follow the rules above automatically.

The Export Depth Map Dialog

To open the Export Depth Map dialog, select File > Facebook 3D Photo… in the main menu. You can also
click the Export button in the main window and choose Facebook 3D Photo.

Settings in the dialog affect the depth map, but make no change in your design.
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1 - The preview area. It can display either the depth map or 3D image depending on the switch below it.
Move the mouse cursor over the 3D preview to see the 3D effect.

2 - The Depth slider changes the max range between the closest and farthest objects. This slider scales up
or down all distances specified by the main slider.

3 - The point that represents the relative distance from the viewer to the object. The position of the viewer is
indicated by the head icon on the left. You can move the object using its circular handle along the slide bar.
How this bar works will be explained later.

4 - Show either the depth map or 3D preview.

5 - Set up the size of the depth map. By default, the fields show the size of your document. In most cases,
you should keep the default size. When you enter new values, the program preserves the aspect ratio of the
depth map automatically.

Adjust Distances to Objects

Objects are represented by planes 2, 4 and 5. 2D objects 4 and 5 have one handle. 3D object 2 has two
handles. These two handles let you better represent the 3D object's depth by indicating the distance to the
closest (1) and farthest (3) points of the object. Some 3D objects can be almost flat. In this case, you place
handles 1 and 3 at almost the same point.

The object order is exactly the same as in your document. The list of layers would show object 2 at the top,
and object 5 at the bottom.
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By moving the handles, you can set the relative distance to each object, but you cannot place them in a
different order. For example, point 4 will always be between 3 and 5. If 2 and 5 are objects placed over a
background 5 in your design, the program will ensure that this order will not be broken when you export a
depth map.

Larger the distance between the leftmost (1) and rightmost (5) points, deeper the 3D effect you will create.

Post Your 3D Photo on Facebook

In order to post a 3D Photo on Facebook, select the created image and depth map in Finder. Then drag them
together into your new post on Facebook. You might see the "Creating 3D Photo" message for a few
seconds before your image appears on the screen. To test the 3D Photo effect, just move the mouse cursor
over the image in different directions.
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Transparent Background
You can export your design as an image with a transparent background. To make it possible, the following
conditions should be met:

Your design should have a transparent background. To check this out, select the Chessboard
background in the program Preferences. The chessboard will be visible through all transparent parts of
your design.
Choose a file format that supports transparency (alpha channel). These are: PDF, TIFF, PNG and GIF.
Activate the Transparent Background option in the Export dialog. The GIF format has the Include
Transparency check box for the same purpose.
It doesn't really concern Art Text, but you should know this. Applications that will receive an image,
which you exported or copied via the clipboard, should also support the alpha channel. If an image has
white or black background in a third party program, try to export from Art Text using a different file
format.
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Printing
To print your document:

1. Select File > Print in the main menu.
2. Set up the printing options.

Make sure that the correct printer and paper format are selected.
You should also check the settings in the Color and Quality as well as Finishing sections. These
sections may have different names depending on the type of printer.
Refer to the printer's documentation for more details.

3. Check if the design looks correct in the preview.
4. Click the Print button.
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Creating and Exporting Animations
The program can help you create animations. Unlike screen recording, this is a step-by-step process. At each
step, you change the object's properties in the design. Then the program detects the changes and creates a
smooth transition from one state of the design to another. Each of these states is represented by a keyframe.
A sequence of keyframes is similar to a timeline in video editors. You can save an animation as a video file or
animated GIF.

Any animation can comprise two or more keyframes with specified transition periods. The speed, at which
visual effects take place, depends on the duration of the corresponding transition. For example, if an object
was relocated by 100 pixels and the transition takes one second, then this object will move 100 pixels per
second in the video.

The app interpolates values of properties between keyframes in the shortest possible way. For example, if an
object has different locations in two keyframes, it will move along a straight line in the animation. If you rotate
an object by 45 degrees, the same angle and direction will be animated. However, if you turn an object by
315 degrees clockwise (which is more than 180), the animation will have this object turning 45 degrees
counter-clockwise because this is the shortest way to reach the final point. In order to animate rotation by
more than 180 degrees, add an intermediate keyframe so that the rotation angles do not exceed 180
degrees.

The resolution of the video is based on the document size. You should set up the document dimensions
before recording a new animation.

When you save a document, it preserves all the information related to the animation. After reopening the
document, you will have the same sequence of keyframes.

Tools for Creating an Animation

1 - A keyframe displaying its index.

2 - An arrow between two keyframes indicates the duration of the transition from one keyframe to another.
You can edit the duration by clicking on it.

3 - Add a new keyframe.

4 - Loop the current animation.

5 - Delete all keyframes.

6 - Close the animation tools. The keyframes and transition settings will be preserved.

7 - Bring up the Export dialog for the current animation.

One of the keyframes can be highlighted with a blue color indicating that it is selected. This is used for
editing keyframes.
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Setting up the Transition

To set up the properties of the transition, click on the arrow that connects two keyframes.

The popup panel lets you change the duration of the transition. You can also select how the animation should
progress through the specified period of time by choosing a transition mode. Values between two keyframes
can be interpolated linearly or nonlinearly. This becomes more clear when we talk about movement. The
Linear option makes an object move with a constant speed. With the Ease option, the object gradually
speeds up or slows down. You can choose different options for the start and end of the movement. For
example, Ease In - Linear Out means that the object starts off slowly and then moves at a constant speed till
the end. With the Spring option, the object will move at a constant speed and oscillate around the end point.
The Amount property adjusts a portion of the transition time taken by the Spring or Ease effect.

Creating an Animation

1. Make sure that your design looks in the same way as the beginning of the video should do.
2. Click on the  button at the bottom of the main window to bring up the animation tools.
3. Click the Add Keyframe button  to add the first keyframe.

You still can make adjustments in the first keyframe.
4. Click on the Add Keyframe button  to add the second keyframe.

5. Make in your design changes that should become animated. These changes will be saved as the
second keyframe because it is selected at the moment.

6. Click the arrow between the two keyframes and set up the duration and transition mode.
7. Repeat the previous steps as many times as you need: add one more keyframe, modify your design

and set up the duration and transition mode.
8. (Optional) To be able to play your animation endlessly, click on the Loop button .

9. Click on the Export Animation button  to proceed to the Export dialog.

Note that you can export having at least two keyframes in the sequence. Changing the duration of any
transition is possible at any time before you open the Export dialog.

The Loop button adds one more keyframe that is exactly the same as the first keyframe. This creates a
smooth transition from the end of the animation to its beginning. Then the external player can be set up to
play your animation repeatedly.



147

In order to delete all keyframes together with transition settings and start from scratch, click the Delete All
Keyframes button . Note that there is no possibility to undo this action.

Editing an Animation

The state of the design on the screen corresponds to a selected keyframe. By default, the app selects the
keyframe that was added most recently. In order to select a different keyframe, click on it. This lets you edit
your design at a state that relates to an earlier keyframe.

You can delete any keyframe except for the first one. To do this, move the cursor over the keyframe's icon.
Click the Delete button that will appear in a corner of the icon.

Exporting an Animation

To export an animation, choose one of the video formats or animated GIF. Then select the resolution and set
up the frame rate and compression. Finally, click on the Save button.
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Animation Transition Modes
Transition modes define how the speed of animation should change within the period of time between two
keyframes. The linear transition should be selected for a constant speed. The rest of the modes make the
speed variable. The following transition modes are available:

Ease In - Ease Out: the transition between two keyframes starts slow and speeds up and then slows
down towards the end.
Linear In - Linear Out: the transition between two keyframes happens with a constant speed.
Linear In - Ease Out: the transition between two keyframes starts at a constant speed and slows down
towards the end.
Ease In - Linear Out: the transition between two keyframes starts slow and speeds up at the starts and
continues at a constant speed.
Spring: Is a special transition mode that has a bumping effect at the end, like a squeezed spring when
released.

In order to change the transition mode, use the drop-down menu in the transition settings.

Examples of Transition Modes

The following images demonstrate examples of transition modes. Each graph shows how a value V changes
over time.

Linear In - Linear Out.

V

Time
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Linear In - Ease Out.

V

Time
Ease In - Linear Out.

V

Time
Ease In - Ease Out.

V

Time
Spring.

V

Time
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Introduction to Generative AI
Art Text can create graphics using Generative AI (Artificial Intelligence). This feature is based on the pre-
trained model which takes as the input a textual description of the image that you want to create. The model
is located on the developer's server. That means that the user must have an Internet connection in order to
send a task to the server and receive the result.

The image generator is a separately paid feature. The first 20 render coins are free to all paid users of Art
Text. You have to purchase one of the packages once your balance is exhausted.

The Gallery contains AI templates finely adjusted for use with the AI generator. It is recommended that you
use primarily those templates for the image generation. As soon as you open such a template, the icon of the
AI Wizard in the main window will have a pink dot .

Images created by AI are random by nature. Because of that, you may need to create several samples and
choose the best. The generated samples are stored in the document that contains your original design. This
allows you to compare the samples.



151

AI Wizard Interface

To open the AI Wizard, click on the  button in the main window. The AI Wizard lets you set up the task for
the AI and start rendering.

1 - Number of remaining render coins and offers the option to purchase more.

2 - Prompt is a textual description of the image that you want to create. Parts of the prompt should be
separated with commas. Only the English language is supported. Example: stones on white background,
glossy, top down view.

3 - The Use Image as Input option allows the AI to use the current design as the input image.

4 - Specifies whether to use colors or only shapes from the current design.

5 - A preview of the input image.

6 - The AI Effect Amount slider determines how much of generative AI will be used in the resulting image. At
the zero value, the image will be identical to the input image.

7 - The Keep Original Shape slider defines how closely the AI must preserve shapes to match the original
design. Set a lower value if shapes in the input image are not so important.
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8 - The Style is a specially trained AI model designed for a specific effect. Such styles are used in AI
templates from the Design Gallery to create specific text effects, including balloon alphabet, fur, oil paint,
bread, water and many more.

When you use the AI Wizard for the first time, there may be no styles in the list. However, once you open an
AI template (free or paid) that includes a style, it will automatically be added to the Style list, and you will be
able to use it in future with your own designs.

9 - Advanced settings.

10 - The Size option allows one to select a dimension preset for the AI generated image.

11 - Starts the image generation process. The number on the button indicates how many Render Coins are
required to render with the current settings. The generation is possible only if you have enough Render Coins
and the connection to the server.

12 - Displays the prompt, seed and other settings used to generate a selected sample.

13 - Zoom in or out.

14 - The preview of the current sample.

15 - Thumbnails of the generated samples. Click on one to preview the corresponding sample.

16 - Export the current sample.

17 - Delete the current sample.

Advanced Settings
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1 - The Negative Prompt describes properties that you don't want to have in the generated image. It can be
left empty. Example: dull, matte, desaturated.

2 - The Seed is a random number that initializes the image generation process. The Seed can be also set
manually. You can copy the Seed from a previously generated image if you want a new image to look like it.

3 - Upscales the current image dimensions. Enabling this option costs an extra render coin.

4 - The Sampler drop-down menu lets you select one of the sampling methods. Samplers that often give
good results are: K_EULER, K_EULER_ANCESTRAL, KDPM2Ancestral, KDPM2 and UniPCMultistep.

5 - Sampling Steps defines the number of sampling steps for the denoising process. Higher value increases
the image quality but takes longer to render. As a rule, values greater than 30 make almost no further
improvement to the output image.

6 - The Universal Control activates the image segmentation. The AI basically tries to define areas in the input
image (individual objects like a flower or letter) in order to fill those with proper details. This mode works well
in most cases and should be preferred to the Contour Control or Depth Control. In this mode, an input image
with less details can still give a good result.

7 - The Contour Control makes the AI find contours in the input image and use those to create the output.
This mode works well with "flat" images containing many small details such as a texture. The model tries to
preserve those details in the output.

8 - The Depth Control option is often used with input images that have details which are distinctly closer to
the viewer than the others. For example, flowers in front and leaves far in the background. With the Depth
Control activated, the AI creates a depth map in order to preserve the feel of different distances to the
objects.

9 - The Use Refiner option activates the two-stage generation. The base model performs the first part of the
task. Then, if enabled, the app runs the refinement model which specializes for the final denoising. The base
model does most of the work and the rest is done by the refiner.

10 - Restores the default settings.
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Generating an Image
Let's take a look at a possible workflow. To generate the first sample, it is recommended that you provide the
image and prompt and keep all the rest settings default.

1. Prepare your design or customize one of the templates from the Design Gallery with the Generative AI
filter selected. Make sure that the aspect ratio of your design is 1:1, 1:2 or 2:1.

2. Bring up the AI Wizard by clicking on the  button in the main window.
3. Decide whether you want to use an image, prompt or both as the input. Using both of them is

recommended, so the following steps will rely on two input sources.
4. Type in the prompt. Use adjectives and nouns rather than complete sentences. Separate parts of the

prompt with commas. Don't use negation in the negative prompt. For example, if you don't want a
dark output, add "dark" to the negative prompt (don't type "not dark").

5. Click the Generate button. The process may take about a minute.
6. The generated sample will appear in the preview. The thumbnail of the current sample will be

highlighted below the preview. If you have already generated several samples, you can compare them
by clicking on their thumbnails. Then you can export one you like or create more samples.

Before creating another sample, decide what you would like to improve. Don't change too many settings at
the same time. If you do that, the result may be less predictable, and you wouldn't know which of the
settings made a new sample better or worse.

Using the same seed with the same prompt, input image and the rest of the settings will produce an identical
result.

One of the strategies may look as follows. Generate a few samples with random seeds (this happens
automatically). Choose a sample that you want to improve, display it in the preview. Click on the "i" icon in
order to bring up the details that are needed to reproduce this sample. Copy the seed. Then open the
Advanced Settings, activate the Use Seed option and paste the seed. Adjust the prompt or other settings
and run the generator once more.

In the same way, you can copy the prompt if a previous description produced a good result.

All generated samples are stored in the same Art Text document along with the original design. This means
that:

If you didn't edit the design but generated images, the document will turn into "edited". You should
save it before closing to have AI generated samples saved.
Your document size will increase as you generate more images. To keep the size under control, you
can delete samples that you don't like. Or export those which you want to keep but don't need them
inside the document. Then delete them from the document.
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